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Chapter 1  

Data Analysis 
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Preparing Data for Data Analysis 
 
Before you start to analyze data using Excel’s various data commands such as Sort, Autofilter, 
Subtotal, Grouping, Consolidate, or PivotTable, you should first inspect your data to determine 
if it is in Analysis-Ready condition. In general, this means that the data must meet the following 
criteria: 
 

a. Contiguous Data – The data should contain no blank rows or blank columns. For example, 
the screen below shows blank rows (with solid lines). These rows should first be removed 
before proceeding with the creation of a PivotTable. 
 

 
 

b. Single Row Data – Some accounting systems produce data that spans two or more rows 
per transaction. If this is the case, your will need to clean that data so that all related 
information for a single transaction or data is contained on a single row. For example, the 
following data contains multiple rows of data related to a single sales order. In this case, 
the user must move and paste the data to fall on a single row. This is an example of data 
that requires a great deal of clean up. 
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c. Column Headers -  The data should contain a unique header atop each column. For 
example, the following screen contains two columns labeled Date, while columns D and 
E contain no heading. These are both cases of data that should be cleaned before creating 
a PivotTable.  
 

 
 
If you attempt to analyze data that does not contain a column heading atop all columns, 
you will sometimes receive an error message, such as the example shown below. 
 

 
 
If you have data with the same column heading used more than once, Excel will 
sometimes alter the column headings, for example when you create a PivotTable, so all 
headings will be unique. 
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d. Row Descriptions – Generally, your data should repeat row descriptions for each row. For 
example, the screen below shows that the state and city descriptions are not repeated 
for each row in columns A & B.  
 

 
 
A solution for quickly filling in the missing row descriptions is presented later in these 
materials. 

 
e. Transposing Headers and Rows – In some cases, data may need to be transposed because 

many of Excel’s Data tools use the column headings, not the row headings to crunch the 
data. To do this, copy the data, then select Paste Special, Transpose, OK to flip the data 
around.   
 

f. Clean Data – The data must be clean of empty text cells containing spaces, special 
characters, extra spaces within data, trailing spaces, trailing zeros, leading zeros, etc.  
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Data Analysis Tools 
 
Excel provides specialized tools for analyzing data and generating financial reports, yet most CPAs 
are unaware of these tools or haven’t tried using them before. Specifically useful are the  
Subtotaling, Grand Totaling, Filtering, Consolidating, Grouping & Outlining, Drilling, OLAP Data 
Cubes, PivotTables, Sparklines, Data Bar Reporting, Conditional Formatting, Charting, Foot 
Notes and End Notes, Formula Auditing Tools, Error Checking, Functions, and Data Analysis 
Tools. 
 
The concepts discussed are intended to directly aide the CPA in summarizing, slicing, dicing and 
analyzing data, and generating related financial reports. 
 
2013 Data Ribbon: 
 

 
 
2013 Insert Ribbon: 
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Data Sort 
 
You would think that every Excel user would already know all about sorting data in Excel, but I am 
frequently surprised to find that many users have missed a few key points related to using this 
tool. I don’t mean to belittle you or talk beneath you, but humor me a couple of paragraphs and 
let’s make sure you are fully up to speed on the following key sorting points: 
 
1. Contiguous Data - The “A to Z” sorting tool can sort a large matrix of data without having to 

highlight the area as long as the data is contiguous; that is to say that your data should contain 
no blank columns, no blank rows, and the columns must all be labeled with a column heading. 
When data is contiguous, all you need to do is place your cursor in a single cell in a given 
column and click the Sort A to Z or Sort Z to A buttons, and Excel will automatically select the 
entire matrix for sorting. Surprisingly many users waste a great deal of time highlighting sort 
ranges prior to sorting, but this step is often unnecessary. 
 

2. A to Z Button - Simply place the cursor in the desired column for sorting, and press the A to Z 
or Z to A button as the case may be. Excel will automatically sort all continuous columns that 
have headings and all contiguous rows from the top row under the heading labels down to the 
last row in the selected column that contains data. (Note - If you accidently select 2 cells 
instead of just one, your results will not be correct.) 

 
3. Sort by 64 Columns - The “Sort” tool was enhanced beginning in Excel 2007 as it now provides 

the ability to sort by up to 64 columns, instead of just 3 columns. Presented below is a dialog 
box which shows this expanded functionality.  
 

 
 

4. Sort Left to Right – Excel has always provided the ability to sort left to right. To do so, select 
the Sort Options box in the Sort dialog box and click the check box labeled Sort Left to Right 
as pictured below. 
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5. Sort by Color – beginning with Excel 2007, you can also sort by font color or by cell color, or 
both. This is handy in many ways. Sometimes CPAs use color to tag or mark certain cells - and 
later find it useful to be able to sort by those markings. In other situations CPAs use conditional 
formatting to apply color to cells using a wide variety of rules; and thereafter they can sort the 
data based on the resulting conditional colors. The two sort-by-color options are pictured 
below. 
 

 
    

To be fair, it was sort of possible to sort by color in Excel 2003. To accomplish this task, you 
needed to use the CELL function in order to identify information about a given cell such as the 
cell color or font color. Thereafter, the results of that function could be used to sort rows – 
which effectively means that you can sort by color in Excel 2003 – but it takes a bit more effort. 
 

6. Sort By Custom List – Another sorting capability in Excel is the ability to sort by Custom List. 
For example, assume a CPA firm has ten partners, and the Managing partner prefers to be 
shown at the top of the list, and the remaining Partners based on seniority. In this case, you 
could create a Custom List in the Excel Options dialog box listing the partners in the desired 
order, and then sort future reports based on that order. 
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To access the Custom List settings: 
 
1. In Excel 2013 & 2010, select File, Options, Advanced, and scroll to the bottom, and then 

select Edit Custom List. 
 

2. In Excel 2007, select File, Options, select Edit Custom List option a few inches down from 
the top. 
 

3. In Excel 2003, select Tools, Options, and click the Custom Lists tab.  
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Filtering Data 
 
AutoFilter allows you to view a subset of your data and when you are done, you can clear the 
filters to once again redisplay all of your data. To use this tool, start with any list of data and turn 
on the AutoFilter tool. Then position your cursor in the column you want to filter and use the 
drop down arrows to apply your filters as suggested in the screen below. 
 

 
 

Once the filters are applied, you will see a subset of your data. For example, the screen presented 
below shows filtered data for only Macon and Savannah properties.  

 

 
 
As filters are applied, a small funnel icon appears in the drop down arrow button to indicate that 
a filter has been applied to that particular column. 
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Key Points Concerning the AutoFilter Command: 
 

1. Contiguous Data – The AutoFilter tools work best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

2. Column Headings –Your columns need unique column headings in a single row, and if the 
column headings are not in row 1, then the row above the column headings should be 
blank so Excel will auto detect the correct range.  
 

3. Filter by Multiple Columns - You can filter by more than one column. 
 

4. Filters are Additive - Each additional filter is based on the current filter and further reduces 
the subset of data. 

 
5. Removing Filters – In all editions of Excel, a fast way to remove multiple filters is to turn 

AutoFilter off and then turn AutoFilter back on. In Excel 2007 and later editions, you can 
also click the Clear button in the Sort & Filter Group as pictured below.  
 

 
 

6. Filter by Color – You can filter based on colors. For example, you can filter by cell color or 
by a list of numbers, you can filter by icon or by a custom filter.  
 

 
 

Note that the Color Filter is mutually exclusive as you cannot also filter by value or text 
when filter by color is applied, and vice versa. 

 

7. Filters Enabled - A drop-down arrow  means that filtering is enabled but not applied. 
 

8. Filter Applied - A Filter button  means that a filter is applied. 
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9. Filter Spanning - The commands 

under the All Dates in the Date 
Filters menu, such as January or 
Quarter 2, filter by the period 
regardless of the year. This can 
be useful, for example, to 
compare sales by a period across 
several years. 
 

10. This Year vs. Year-to-Date - This 
Year and Year-to-Date are 
different in the way that future 
dates are handled. This Year 
filtering can return dates in the 
future for the current year, 
whereas Year-to-Date only 
returns dates up to and including 
the current date based on the 
computer’s time clock. 
 

11. Filtering Dates - All date filters are based on the Gregorian calendar as decreed by Pope 
Gregory XIII, after whom the calendar was named, on 24 February 1582. The Gregorian 
calendar modifies the Julian calendar's regular four-year cycle of leap years as follows: 
Every year that is exactly divisible by four is a leap year, except for years that are exactly 
divisible by 100; the centurial years that are exactly divisible by 400 are still leap years. For 
example, the year 1900 is not a leap year; the year 2000 is a leap year. 

 
12. Filtering By Days of Week - If you want to filter by days of the week, simply format the 

cells to show the day of the week, or 
insert a new column and use the 
WEEKDAY function to calculate the 
week day, and then apply filters using 
this new column. 
 

13. Top & Bottom Filtering - On the Data 
tab, in the Sort & Filter group, click 
Filter. Point to Number Filters and 
then select Top 10. To filter by 
number, click Items. To filter by 
percentage, click Percent. Note - Top 
and bottom values are based on the 
original range of cells or table column 
and not the filtered subset of data. 
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14. Above & Below Average Filtering - On the Data tab, in the Sort & Filter group, click Filter. 
Select Number Filters, Above/Below Average. Note – These values are based on the 
original range of cells or table column and not the filtered subset of data. 
 

15. Filtering Out Blanks - To filter out blanks, in the AutoFilter menu at the bottom of the list 
of values, de-select the check box labeled Blanks. 
 

16. Filtering By Color - Select Filter by Color, and then depending on the type of format, select 
Filter by Cell Color, Filter by Font Color, or Filter by Cell Icon. Note that these filter options 
only show up when there are actual cell colors, font colors or icons included in the data 
range.  
 

17. Filter by Selection - To filter by text, number, date, time, or color for selected cell(s), select 
the cells to be used as a filter basis and then right-click that selection, and from the popup 
menu select Filter, Filter by Selected Cell's Value, (or Filter by Selected Cell's Color, Filter 
by Selected Cell's Font Color, or Filter by Selected Cell's Icon). 
 

 

 
 

18. Refreshing Filters - To reapply a filter after the data changes, click a cell in the range or 
table, and then on the Data tab, in the Sort & Filter group, click Reapply. 
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Data Form 
 
Excel’s Data Form tool provides a data input window which makes Excel look and behave more 
like a database, such as Microsoft Access. (Note that in Excel 2013, 2010 and 2007, the Form tool 
button has not been included on the Ribbon, so to use it you will first need to add the Form tool 
button to the Quick Access Toolbar.)  
 

 
 

A data form provides a convenient means to enter or display one complete row of information 
in a range or table without scrolling horizontally. Some people, especially those who are used to 
using databases, find that using a data form can make data entry easier than moving from column 
to column when you have more columns of data than can be viewed on the screen.  
 
Key Points using Data Form: 
 

1. You cannot print data from a data form. 
  
2. Because a data form is a modal dialog box, you cannot use either the Excel Print command 

or Print button until you close the data form.  
 
3. You might consider using the Windows Print Screen key to make an image of the form, 

and then paste it into Microsoft Word for printing. 
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Data Subtotals 
 
Excel’s Subtotal command automatically calculates and inserts subtotals and grand totals in your 
list or table. Once inserted, Excel recalculates subtotal and grand totals as you enter and edit the 
detail data. The Subtotal command also outlines the list so that you can display and hide the 
detail rows for each subtotal. Examples of the Subtotal dialog box and a resulting subtotaled 
table are shown below. 
 

  
 

 
 

To display subtotals and grand totals at the top instead of the bottom, deselect the checkbox 
labeled Summary below data.  
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Key points to Consider When Using Subtotaling are as follows: 
 

1. Contiguous Data – The Subtotal tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

2. Sort Before You Subtotal - You must sort the data by the column you wish to subtotal by, 
else you will receive erroneous results.  

 
3. Other Mathematical Applications - The Subtotal tool not only calculates subtotals, but it 

can also calculate minimums, maximums, averages, standard deviations, and other 
functions.  

 

 
 

4. Subtotals in 2013, 2010 & 2007 Tables – Excel 2007 added a new Table tool which enables 
Subtotals a little differently; the Subtotal tool appears at the bottom of each column in 
each Table, as shown in the screen below. 
 

 
  

5. Automatic Outlining – The Subtotal tool automatically inserts Outlines, which allows you 
to collapse or expand your data.  
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6. Copying Outline Data - Some CPAs also like to copy and paste collapsed subtotal data to 
another location, but they find this process copies and pastes all of the data – not just the 
summary data they desire. In this situation, there are two ways to achieve a clean copy 
and paste without grabbing all the hidden data as follows: 
 

a. CTRL key – Hold the Control Key down while you individually click to select 
individual rows; this action will enable you to copy and paste selected data. 
However, this approach can sometimes be problematic because if you miss-click, 
you have to start over. 

 
b. Select Visible Cells – A better approach is to use the Select Visible Cells tool. This 

tool will select on the data you can see, after which the copy and paste routine 
will yield the desired results. This option is better because it is faster and less error 
prone.  

 

 
 

c. Go To – You can also select visible cells using Go To. To do this, press F5 to launch 
the Go To tool and then click Special. In the Go To Special dialog box, select the 
radio button labeled Select Visible cells and press OK.    
 

 
 

d. ALT + ; - The Alt + ; key combination is the shortcut to using the Select Visible Cells 
Tool.  
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Data Validation  
 

Data Validation can be used to limit the data that can be entered into a cell. For example, you 
might want the user to enter only values between 1% and 99%. You might also use this tool to 
enable data input to a drop down list which offers two advantages in that it can be faster and 
more accurate.  To create a dropdown list, enter a list into sequential cells in Excel. Next, from 
the Data tab select Data Validation, Data Validation (yes, again), then in the dialog box (as shown 
below) select List from the Allow dropdown box and then indicate the data range for your list in 
the Source box. 
 

 
 
After making all the necessary selections in the validation list dialog box, your worksheet will 
produce a cell containing a drop down list (shown in cell A10 below) that behaves as shown.  
 

 
 
You can also provide messages to define what input you expect for the cell, and instructions to 
help users correct any errors. For example, on a worksheet, you can set up a cell to allow only 
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account numbers that are exactly three characters long. When users select the cell, you can show 
them a message such as this one: 
 

 
 
If users ignore this message and type invalid data in the cell, such as a two-digit or five-digit 
number, you can display an actual error message. In a more advanced scenario, you might use 
data validation to calculate the maximum allowed value in a cell based on a value elsewhere in 
the workbook. In the following example, the user has typed $4,000 in cell E7, which exceeds the 
maximum limit specified for commissions and bonuses. 
 

 
 
If the payroll budget were to increase or decrease, the allowed maximum in E7 would 
automatically increase or decrease with it. 
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Data Table (“What-if Analysis”)  
 
Data tables are part of the collection of what-if analysis commands, which include:  
 

1. Data Tables 
2. Goal Seek 
3. Scenarios 

 
The Data Table command enables the process of changing values in cells to see how those changes 
will affect the outcome. For example, you can use a data table to vary the interest rate and term 
length used in a loan to determine possible monthly payment amounts.  
 
There are two types of Data Tables – One Way and Two Way. A data table cannot accommodate 
more than two variables. If you want to analyze more than two variables, you should use 
scenarios. Although it is limited to only one or two criterion (one for the row input cell and one 
for the column input cell), each criterion can include as many different variable values as you want. 
(In contrast, a Scenario can have a maximum of 32 different criterion, but you can create as many 
Scenarios as you want.) 
 
Loan Analysis Example  
 
In this exercise, we start by creating a simple Payment function to calculate the payment amount 
of a loan given a loan amount, interest rate and number of periods.  
 

 
 

The next step is to create a Two-Way Data Table displaying the resulting payment amount given 
a variety of lengths of the loan. This process is started by creating a list of the alternative loan 
amounts, as shown below in B8, B9, B10, etc. Cell C7 must reference the results you want to be 
displayed in the table. 
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Next, highlight the data table range and use the Data Table command on the Data tab (as 
shown below) to generate the desired table. 
 

  
 

This process will generate the following table: 
 

 
 
This table tells us that the same loan amount will require a monthly payment of $4,972 to pay 
the loan off in just 6 years, or a monthly payment of $5,800 to repay the loan in just 5 years.  
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The next step in this exercise is to generate a line chart based on the data table we just created. 
This line chart will provide some interesting observations regarding the benefits and detriments 
of paying off loans over longer periods. 
 

 
 

The resulting chart is shown as follows: 
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Based on this, no one should ever obtain a fair market loan for more than 15 years, the reduction 
in payments simply aren’t worth the additional length of the loan. This same basic behavior is 
seen whether the interest rate is 1% or 100%, or whether the loan amount is $1,000 or 
$10,000,000. The only time you might be justified in obtaining a loan longer than 15 years might 
be when you are extended a favorable interest rate (perhaps from a rich uncle), better than a fair 
market interest rate. 
 

Goal Seek 
 
If you know the result that you want from a formula, but are not sure what input values are 
needed to produce your desired results, use Goal Seek. For example, suppose that you have 
decided to purchase a house, but you don’t know how much house you can afford. In this case, 
you know how the interest rate (3.75%) and how long you want to take to pay off the loan (15 
years), and the amount you can afford to pay each month ($2,800). In this case, you can use Goal 
Seek to work backwards to figure out how much house you can afford. Start by calculating the 
monthly payment based on any random home loan amount as pictured below.  
 

 
 

Next, from the Data tab, select What-If Analysis, Goal Seek. Fill in the parameters to set the 
payment amount to $2800 by adjusting the Loan Amount, as shown, and then click OK.  
 

 
 

The result is that a person with $2,800 available to make monthly payments can afford to 
purchase a home costing up to $385,027 (assuming a 15 year loan and 3.75% interest rate) – as 
pictured above. (Keep in mind that anyone actually following this scenario would need to 
consider that homes also come with other monthly obligations including real estate taxes, 
insurance maintenance, etc.)   
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Data - Text to Columns 
 
CPAs sometimes receive data from their clients or IT departments that is in text form. When this 
happens, Excel can split the contents of one or more cells in a column and distribute those 
contents as individual parts across other cells in adjacent columns. For example, the worksheet 
below contains a column of full names and amounts that you want to split into separate columns. 
The Text to Columns wizard parses the data automatically into separate cells. To use this tool, 
select the cell, range or entire column that contains the text values that you want to split.  
 

 
 
 
 
 
Notes:   
 

1. A range that you want to split can include any number of rows, but it can include no more than 
one column.  
 

2. You also should make sure there are enough blank columns to the right of the selected column to 
prevent overwriting existing data in those adjacent columns. 
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Flash Fill  
 
Of all the Office 2013 applications, Excel is the beneficiary of the most impressive enhancements. 
Excel’s new Flash Fill watches you work and applies logic to help you complete your tasks. The 
example pictured below contains a list of 44 first and last names in Column A, which I want to 
separate into Columns B and C. As I start typing the first name of the second record in Column B; 
Excel’s Flash Fill guesses what I’m trying to do and offers to fill in the remaining 42 first names 
(as shown in grey text). 
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Data Grouping & Outlining  
 
If you have a list of data that you want to group and summarize, you can create an outline of up 
to eight levels. Each inner level (represented by a higher number in the outline symbols) displays 
detailed data for the preceding outer level, represented by a lower number in the outline 
symbols. Use an outline to quickly display summary rows or columns, or to reveal the detail data 
for each group. You can create an outline of rows (as shown in the example below), an outline of 
columns, or an outline of both rows and columns. 
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PowerView 
 
Excel’s new PowerView inserts new worksheets connected to your data, and then enables you 
to create new report types, such as the interactive map chart presented below. The resulting 
PowerView Map report is zoomable, and filters can be applied to display partial data. 

 

 
 
PowerView worksheets can be published as standalone, interactive reports to Microsoft 
SharePoint’s PowerPivot Gallery or other reporting service destinations. Some of the tools 
provided by PowerView include the ability to create a dashboard containing multiple 
PowerViews, apply themes and backgrounds, insert pictures and text boxes, insert collapsible 
and expandable tiles, and add data slicers.  
 
PowerView Learning Points 
 

1. Included - PowerView isn’t included in Office Home editions. Power View and PowerPivot are only 
available in the Office Professional Plus and Office 365 Professional Plus editions.  

2. Worksheet - PowerView is another sheet in the workbook, and acts like a Dashboard.  
3. Fields – Add data to the PowerView by selecting fields, much like you do for PivotTables. 
4. Play - You can play charts to see how they change over time. 
5. PowerView uses PowerPivot - Known to be extremely fast for retrieving and sorting data.  
6. Relationships – PowerView can integrate multiple data sets via relationships. 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright May 2014 – J. Carlton Collins  Page 31 

Timeline Slicer 
 
CPAs who work with PivotTables will likely appreciate Excel’s new Timeline Slicer which helps 
users slice and dice Pivot data that contain dates. As an example, selecting the dates May through 
October on the Timeline slicer pictured below adjusts the PivotTable to display May thru October 
data.  

 

 
 

 

Quick Analysis 
 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, charts, 
totals, tables and sparkline layouts to instantly summarize large volumes of data (see screen 
below). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
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Queries 
 
Excel 2010, 2007 & 2003 include pre-designed “queries” that can import commonly used data 
such as stock quotes for updating a stock portfolio. All you need is a connection to the internet 
and of course, some stock ticker symbols. In Excel 2010 or 2007 select Data, Existing 
Connections, MSN MoneyCentral Stock Quotes (or in Excel 2003 select Data, Import External 
Data, Import Data Existing Connections, MSN MoneyCentral Stock Quotes) and then walk 
through the web query wizard for importing stock quotes. In just a few seconds, Excel will retrieve 
Real-Time data for NYSE, NASDAQ & AMEX, and 20 minute delayed stock prices from other 
exchanges (during the hours when the stock market is open) and display a grid of complete up-
to-date stock price information that is synchronized to the stock market’s changing stock prices. 
With each click of the “Refresh” button, the stock price information in Excel is updated - this sure 
beats picking numbers out of the newspaper.  
 

 
 
Completing the Stock Portfolio – Next link the grid data to another worksheet, and insert new 
columns containing the number of shares owned, as wells as an additional column to compute 
the total value based on shares owned, as shown below. 
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Refreshing the Stock Prices - Once you have created your portfolio, simply click the Refresh Data 
button on the “External Data” Toolbar in Excel 2003 or on the “Data Ribbon” in Excel 2010 & 
2007 shown below to update the current value of your Portfolio. 
 

 
 
Query Parameters - There are numerous options to help you extract exactly the data you want 
the way you want it. The “Web Query Parameters Box”, “Web Query Options Box” and “External 
Data Properties Box” provide numerous options for controlling your web query. 
 
Excel 2013 Stock Quote Queries 
 
In Excel 2013, for unknown reasons Microsoft has removed the stock quote query option, 
therefore below are instructions for restoring this option.  
 

1. Launch Notepad (Start, Programs, Windows Accessories, Notepad) 
 

2. Enter the following information exactly: 
 

 
 

Web 
1 
http://moneycentral.msn.com/investor/external/excel/quotes.asp?SYMBOL=["QUOTE","Ent
er stock, fund or other MSN MoneyCentral Investor symbols separated by commas."] 

 
 

Or if you prefer, use this to query Yahoo’s stock prices:  
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3. Save the file using any name you want, but be sure to include the extension .igy as 
pictured. 

 

 
 

4. Make sure to save this file to the folder labeled My Data Sources. 
 

 
 

5. Now in Excel, from the Data tab select Existing Queries, then scroll to and launch the new 
query you just created – it should work just like it did in Excel 2010, 2007 and 2003. 
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Database Queries  
 
Microsoft Excel can also query and retrieve data you want from an external data source. For 
example, you can retrieve Microsoft Excel data about a specific product by region. You can create 
a simple query by using the Query Wizard, or you can create a more complex query by using the 
advanced features of Microsoft Query. 
 
To use Microsoft Query to retrieve external data, you must: 
 

1. Have access to an external data source - If the data is not on your local computer, you 
may need to see the administrator of the external database for a password, user 
permission, or other information about how to connect to the database. 
 

2. Install Microsoft Query - If Microsoft Query is not available, you might need to install it. 
 

3. Specify a source to retrieve data from, and then start using Microsoft Query -   For 
example, if you want to insert database information, display the Database toolbar, click 
Insert Database, click Get Data, and then click MS Query.  

 
For example, suppose we have some data in our accounting system – Sage MAS 200 ERP that we 
would like to analyze in Excel.  We can use the Database Query Wizard to build a query that will 
extract the data we need and place it in an Excel spreadsheet, as follows. 
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The first step is to select the type of database you want to query and to select the specific 
database. 
 

 
 
Upon the selection of the desired database a list of tables will be presented. Choose the desired 
tables, and select the desired data fields to be imported. You will then have the option to filter 
and sort the data before it is imported.  Finally you will be given the option to save the query so 
you can run it at a later date without having to start from scratch. Excel will then return a table 
full of the data you requested as shown in the screen below. 
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Introduction to PivotTables   
 
The PivotTable report tool provides an interactive way to summarize large amounts of data. Use 
should use the PivotTable tools to crunch and analyze numerical data PivotTable reports are 
particularly useful in the following situations: 

 
a. Rearranging rows to columns or columns to rows (or "pivoting") to see different 

summaries of the source data.  
b. Filtering, sorting, grouping, and conditionally formatting your data. 
c. Preparing concise, attractive, and annotated online or printed reports. 
d. Querying large amounts of data. 
e. Subtotaling and aggregating numeric data. 
f. Summarizing data by categories and subcategories. 
g. Creating custom calculations and formulas. 
h. Expanding and collapsing levels of data. 
i. Drilling down to details from the summary data. 
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In essence, PivotTables present multidimensional data views to the user – this process is often 
referred to as “modeling”, “data-cube analysis”, or “OLAP data cubes”.  To re-arrange the 
PivotTable data, just drag and drop column and row headings to move data around.  PivotTables 
are a great data analysis tool for management.   
 
If you have never used a PivotTable before, initially the concept can be difficult to grasp. The best 
way to understand a PivotTable is to create a blank Pivot Table and then drag and drop field 
names onto that blank table. This way you will see the resulting pivot table magically appear and 
it will help you better understand the important relationship between the pivot pallet and the 
field name list. 
 
Let’s create a simple PivotTable. Start with an Excel worksheet data that contains several columns 
of data – the data must include column and row headings and it helps if the data is contiguous. 
Place your cursor anywhere in the data and select PivotTable from the Data menu in Excel 2003 
and click Finish; or from the Insert tab in Excel 2007.  This process is shown below: Let’s start with 
a page of data summarizing the results of tax season as all of the time sheet entries have been 
entered onto a single worksheet as shown below.  
 

 
 
Place your cursor anywhere in the data and select PivotTable from the Insert Ribbon as shown 
below: 
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For learning purposes let’s right mouse click on the PivotTable and select PivotTable Options, 
Display, Classic PivotTable Layout. Your screen will now appear as follows: 
 

 
 

I like for CPAs to learn how to use Pivot Tables in this view because it visually helps them 
understand the all important relationship better the blank pivot palette and the PivotTable field 
List, both elements of which are shown in the screen above. 
 
To proceed, simply drag and drop field names shown on the right onto the blank Pivot palette 
shown on the left. With each drop, your report grows larger. As an alternative you could use the 
check boxes next to field names – this functionality is new in Excel 2007. After adding some data 
to your blank Pivot Palette, your data will look something like this: 
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Next format and filter the Pivot Report. Very quickly your report comes together as shown below. 
Notice the filter button has been applied and a PivotTable style has also been applied for 
appearance.  
 

 
 
Double clicking on any number in a Pivot Report will automatically produce a new worksheet 
complete with all supporting detail that comprises the summary number.  
 
There are a multitude of PivotTable options that can be applied to alter the appearance or 
behavior of your PivotTable.  
 
Key Points Concerning Pivot Tables are as Follows: 

 
a. You can create as many Pivot Reports as you want from your initial raw data page. Your raw data 

remains unchanged as new PivotTables are created. 
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b. As your raw data changes, your PivotTables are updated each time you press the refresh button. 

Or if you prefer you can set your PivotTables to update themselves at regularly scheduled intervals 
– say every ten minutes. 
 

c. A key to understanding PivotTables is understanding the relationship between the Blank Pivot 
palette and the PivotTable Field list. As data is selected in the list, it appears on the PivotTable 
Report.  
 

d. You can alter the PivotTable simple by dragging and dropping the field names in different locations 
on the Pivot palette, or in different locations in the PivotTable Field list Box. 
 

e.  PivotTables can be pivoted. 
 

f. PivotTables can be sorted by any Column. (Or by any row when sorting left to right) 
 

g. PivotTables can be Filtered. 
 

h. PivotTables can be Drilled. 
 

i. PivotTables can be copied and pasted. 
 

j. PivotTables can be formatted using PivotTable Styles, as shown below. 
 

 
 

k. Subtotals and grand totals can be displayed or suppressed at the users desire. 
 

l. PivotTable Data can be shown as numbers or percentages at the users desire. 
 

m. PivotTables can not only be summed, they can be averaged, minimized, maximized, counted, etc. 
 

n. Blank rows can be displayed or suppressed at the users desire. 
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o. A new feature called “Compact Form” organize multiple column labels into a neatly organized 

outline which is easier to read. 
 

p. PivotTables can query data directly from any ODBC compliant database. The PivotTable tool for 
accomplishing this task is not included in the ribbon – you will find it by Customizing the Quick 
Access Tool Bar and searching the “Commands Not Shown in the Ribbon” tab to find the PivotTable 
and PivotChart Wizard Option. 
 

q. Many accounting systems can push data out of the accounting system into an Excel PivotTable 
format – this is commonly referred to as an OLAP Data Cube. OLAP Data Cube is just a fancy word 
for PivotTable – and there is no difference.  
 

r. PivotTables can automatically combine data from multiple data sources. The PivotTable tool for 
accomplishing this task is not included in the ribbon – you will find it by Customizing the Quick 
Access Tool Bar and searching the “Commands Not Shown in the Ribbon” tab to find the PivotTable 
and PivotChart Wizard Option. 
 

 
 

s. Excel also provides a PivotChart function which works similarly to PivotTables. Presented below is 
an example PivotChart.  
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Excel 2003 PivotTables work very similarly as shown below. Excel creates a blank PivotTable, and 
the user must drag and drop the various fields from the PivotTable Field List onto the appropriate 
column, row, or data section. As you drag and drop these items, the resulting report is displayed 
on the fly. Here is the blank Pivot Palette view. 
 

 
 
Now drag and drop field names from the Pivot Table field list onto the Pivot pallet. This action will 
automatically create Pivot Table reports – and they will change each time you drop additional field 
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names, or move field names around. Presented below are but a few examples of hundreds of 
possible reports that could be viewed with this data through the PivotTable format. 
 

 
 
This report shown above shows the total resulting sales for each marketing campaign for each of 
the 4 months marketing campaigns were conducted. 
 

 
 
In this screen we see the same information is shown as a percentage of the total. A few 
observations include the fact that overall Radio Spots are the most profitable type of campaign, 
but only in April and July. In January and October, local ads and direct mail, respectively, produce 
better results. Further, April campaigns had the best response overall. 
 

 
 
Further analysis in the screen above tells us that our results vary widely from one city to the next. 
In New York, coupons were least effective, but coupons were most effective in Columbus. Pivot 
charts based on PivotTable data can be modified by pivoting and/or narrowing the data.  They can 
also be published on the Internet (or on an Intranet) as interactive Web pages.  This allows users 
to “play” with the data. The chart below provides a visual look at the data shown above. 
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Filtering Pivot Tables - If you take a close look at your resulting pivot tables, you will notice that 
Excel automatically inserts a filter button on each field list as shown by the drop down arrows in 
the screen below:  
 

 
 
This drop down filter list makes it easy to refine your report to include just the data you want. 
 
Drilling Pivot Tables - Another nice feature in pivot tables is that they are automatically drillable. 
Simply double click on any number in a pivot report to have Excel automatically insert a new sheet 
and produce the detailed report underlying the number you clicked on. An example of this is 
shown below: 
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Pivot Table Options - By right mouse clicking on your PivotTable you will reveal several 

option settings boxes as shown below. For example, these options boxes control the types of 
subtotals produced in your Pivot Reports. Excel also offers a PivotTable options box as well as a 
layout wizard that makes producing PivotTables a little easier.  
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Chapter 2 

Excel Financial 
Reporting Tips & Tricks  
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Excel’s Financial Templates 
 
Microsoft Excel provides thousands of templates online so you don’t have to start from scratch. 
To access these templates, select File, New and in the Home box type “financial”, and click the 
search tool. Excel will display thumbnail images of dozens of workbooks that are ready for 
immediate download and use – free of charge. 
 

 
 
Double-clicking a template displays a brief description of the template, along with the file size 
and its user rating. In the example Financial Statement Ratios template summarized below, you 
can see that 12 people have rated this template with 3.5 out of 5 possible stars.  
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Click the Create button located at the bottom of the dialog box to open it on your computer.   
 

 
 

As you can see in this example, the workbook column and row headings have been suppressed, 
but you can switch them back on with a few quick Option settings.  
 

Foot Your Financials in Excel 
  
You can embed a Word document in Excel as an object to provide Word processing functionality 
within Excel, which makes the process of adding footnotes much easier. To embed a Word 
document in an Excel worksheet, select Object from the Insert tab or menu, then 
select Microsoft Word Document and click OK. Use the mouse to resize and reposition the 
resulting embedded Word document object underneath the financial statement (or in the 
appropriate position) as pictured below. 
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The resulting embedded Word object will allow you to type using the same word processing 
functionality provided by Word, such as outline numbering, paragraph justification, indenting 
and Word shortcuts (such as Shift+F3 to change case). When you click away from the Word 
object, the Word menus disappear and the Excel menus return to normal. Double-clicking on the 
Word object reactivates the embedded object, allowing you to further edit its contents using 
word processing functionality. 
  
To finalize your footnotes, consider adding the following finishing touches: 
  
1. Font. For consistency, change the footnote font to match the font used in the financial 
statements. 
  
2. Border. Click away from the Word box to deactivate the object, and click the Word box once 
to select it. Right-click on the edge of the Word object to display the pop-up menu, and 
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select Format Object. On the Colors and Lines tab, click the Line Color dropdown arrow and 
select No Line, and click OK. 
  
Once printed, the resulting footnotes will appear seamlessly at the bottom of the financial 
reports, as shown below (note that this is not the same as a footer and does not behave like a 
footer when printing). 
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Footnote References in Excel  
 
CPAs often struggle to include footnote references in their Excel-based financial statements, they 
can’t seem to get the footnote references to appear the way they would like. Following are two 
common approaches to including footnotes, both of which fall short. 

 

 

Because of this problem, many CPAs take the extra steps of copying and pasting the financial 
statements into Word, then editing the financial report further before printing.  

Solution: Excel allows you to format each character in a given cell individually, and this trick can 
be used to achieve the result you desire. To accomplish this, enter the row description and 
footnote reference into the same cell. Highlight the cell and activate edit mode (by pressing the 
F2 key or by double-clicking the cell). Use the mouse (or the arrow keys while holding down the 
Shift key) to highlight the footnote reference portion of the text (see below).  

 

Next, right-click on the cell to display the pop-up menu and select Format Cells. Click the 
Superscript checkbox, and click OK. As pictured below, this action will display the footnote 
reference in superscript format, like Word does. 
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Controlling Underlines in Excel 
  
CPA Question: Because I think the solid underlines on my Excel-based financial reports look less 
professional, I insert thin, blank columns between my data so the underlines don’t touch one 
another. This process of inserting and reformatting columns is tiresome. Is there another way to 
produce the underline breaks I want without having to insert blank columns between my data? 
The screenshots in the next column provide an example of my data before (with solid underlines) 
and after inserting blank columns (with underlines that don’t touch). 

     

A: There is a slightly better option. Excel’s Accounting Format was designed for accountants, and 
it allows you to insert non-touching single and double underlines in adjacent columns. Below are 
the five steps needed to apply this format using your example data: 

1. Add double underlines. Highlight the total row, right-click on the total row, select Format 
Cells from the pop-up menu, and then on the Font tab, select Double Accounting from 
the Underline dropdown box, then click OK. 

 

2. Add single underlines. Highlight both the header row and the row above the total row (hold 
the Ctrl key down to select multiple ranges), right-click anywhere on the highlighted range, and 
then select Format Cells from the pop-up menu. Next, on the Font tab, select Single 
Accounting from the Underline dropdown box, then click OK. 
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3. Format the numerical data. Highlight the numerical data, right-click anywhere on the 
highlighted range, and select Format Cells from the pop-up menu. Next, on the Number tab, 
select Accounting from the Category list box, set the Decimal places spinner to 0, select the dollar 
symbol ($) in the Symbol dropdown box, and click OK. (Note: After applying the accounting 
format, not only do commas and dollar signs appear, but the single and double accounting 
underlines will also resize to match.) 

 

4. Remove unwanted dollar signs (optional). Highlight the numerical data where you want to 
suppress the dollar signs, right-click anywhere on the highlighted range, select Format Cells from 
the pop-up menu, and then on the Number tab, select None from the Symbol box and click OK. 

 

5. Control text underlines. Notice in the image at the bottom of the previous column that the 
header underlines are larger than the numeric underlines. To correct this problem, highlight the 
header row, right-click anywhere on the highlighted range, select Format Cells, and on 
the Number tab, select the Accounting format from the Category list box. Note: This step may 
sound strange, but you must format the header text using the accounting format in order for the 
size of the underlines below the headers to match the underlines in the numeric data. These 
steps will produce the desired format in adjacent columns, as pictured below. 
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While these steps may also be tiresome, this approach eliminates blank columns, making it easier 
to navigate using the End+Arrow Keys combinations, and to perform other operations such as 
sorting, filtering, and subtotaling. 

Subtracting Columns in a PivotTable 
  
CPA Question: For many years we have created PivotTables in Excel, but it is frustrating because 
there doesn’t seem to be a way to add, subtract or divide columns. We want to subtract our 
actual columns from our budget columns to produce the difference and difference percentages. 
If there is a way to do this, we have never been able to find it. Can you help us? 
  
Solution: You are not alone; many CPAs struggle with this same situation. The problem arises 
when you use your mouse to write a formula that references a cell in a PivotTable. In this case, 
Excel automatically inserts the GETPIVOTDATA function into your formula, as shown below in cell 
D2. 
  

 

As a result, the formula cannot be properly copied with relative references to adjacent cells. 
  
Presented below are two possible solutions: writing formulas using the keyboard, and inserting 
calculation columns into the PivotTable. 
  
1. Writing formulas using the keyboard. If you write formulas that reference PivotTable cells by 
typing cell references into the formula using your keyboard instead of pointing to the cell using 
your mouse, Excel does not insert the GETPIVOTDATA function. The screenshot below shows the 
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resulting formula in column D (=C2–B2), which was created using the keyboard instead of the 
mouse pointer. 
  

 

This formula can then be copied to the cells below to produce the desired column differences. 
(Note: A problem with this method is that as you refresh your PivotTable, it may grow or shrink, 
which could reposition data in different cells. As a result, formulas created with your keyboard 
may no longer reference the correct data cells.) 
  
2. Inserting calculation columns into the PivotTable. A better approach is to insert a new 
calculation column into your PivotTable using the Fields, Items, & Sets tool. To use this tool in 
Excel 2010, first select a cell within the PivotTable you want to modify, then from the PivotTable 
Tools menu, select Options, Calculations, Fields, Items, & Sets as shown below. (In Excel 2007, 
select PivotTable Tools, Options, Formulas, Calculated Field). 
  

 
 

In the resulting Insert Calculated Field dialog box (shown below), type a name (to appear as the 
column label) in the Name box, then create the desired formula you want in the Formula box. To 
create the formula, start by inserting an equal sign, then select the column you want to appear 
in your formula from the Fields box and click the Insert Field button to add that field to your 
formula. Add mathematical operators (such as “+”, “–,” “/” and “*”) and continue this process 
until your formula is complete. (Note: The Formula box displays only one line of your formula at 
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a time, making it difficult to view formulas in their entirety. Therefore, when creating lengthy 
formulas, you must use the left and right arrow keys to scroll, view and edit it.) 
  

 

When you have completed your formula, click OK and the resulting new calculation column will 
appear as follows: 
  

 

Repeat this process to insert an additional column to calculate the percentage difference. 
  
Note: The fact that Excel automatically inserts the GETPIVOTTABLE function into formulas when 
referencing PivotTable data frustrates many CPAs, but actually, it is a good solution because it 
allows those formulas to continue to reference the correct data, even if the PivotTable shrinks or 
grows. 
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A PivotTable Column Worth Repeating 
  
CPA Question: How do I add a percentage-of-total column in a PivotTable in Excel 2013 or 2010? 

Solution: The previous tip explains how to add a calculated column to a PivotTable. That solution 
could work, but in this particular situation, I’d like to offer an easier option, using Excel’s Show 
Values As function. To use this feature, in the PivotTable’s Field List, drag the value field name 
that you want to summarize by amounts and percentages into the Field List’s Values box twice. 
This action repeats the value columns in the PivotTable, as shown below. 

 

 
Next, right-click anywhere on the second value column (Sum of Revenue2 in this example) and 
select Value Field Settings from the popup menu. In the resulting Value Field Settings dialog box, 
click the Show Value As tab and select % of Column Total from the Show Values As dropdown 
box, and then click OK. 

Your PivotTable will now display the same two columns of data both numerically and as a 
percentage of total, as pictured below. (In this example, I double-clicked and edited each 
column’s title to better describe the data.) 
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Note: This option also can be accessed from the PivotTable Tools tab by selecting 
the Options tab, Calculations, Show Values As. 

E-Mailing A Single Worksheet 
 
CPA Question: What is the easiest way to send a single Excel worksheet to a staff member 
without sending them the entire workbook? 
 
Solution: You can send a single worksheet (ie: not the entire workbook) from within Excel using 
the integrated Outlook Send this Sheet applet, as follows: 

 
1. Launch the E-Mail dialog box tool as follows: 
 

In Excel 2003 - Select File, Send to Mail Recipient. 
 
In Excel 2007 - 2013 – Right mouse-click on the Quick Access Toolbar and select Customize 
Quick Access Toolbar. In the Choose commands from: drop down box, select Commands Not 
in the Ribbon. Scroll down and select Send to Mail Recipient, and click the Add>> button to 
include this command on your Quick Access Toolbar. Click OK. Click the Send to Mail 
Recipient icon on the Quick Access Toolbar.   
 

2. In the E-Mail dialog box, select the radio button labeled Send the current sheet as the 
message body, and click OK.  
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3. This action creates an e-mail message using the worksheet contents as the e-mail message 
with limited Outlook tools and functionality as shown below. Enter the e-mail recipients and 
subject as you would normally when preparing an E-mail message, and click Send the Sheet.   

 

 
 
The Send This Sheet menu is integrated with Outlook so that the To…, Cc…, and Bcc… drop down 
fields will display your contacts and contact groups you maintain in Outlook. Once the e-mail is 
sent, a copy of the e-mail appears in your Outlook Sent Items box, similar to that of a regular e-
mail. 
 
Cautionary Note 1: When using this Send the current sheet as the message body option, the 
Excel data is converted from an Excel format into a table format containing only values. To send 
a single worksheet with the Excel formulas intact, make a copy of the workbook, delete all of the 
worksheets except for the one you intend to send, and repeat the steps above using the Send 
the entire workbook as an attachment option.  
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Cautionary Note 2: When sending e-mails from within Excel, your default signature block is not 
inserted into the e-mail. 
 
Cautionary Note 3: This functionality works well with Outlook, but does not necessarily work 
with other e-mail client applications.  

 
Animating Excel Charts in PowerPoint by Data Series 
 
PowerPoint 2010 allows you to animate your charts by data series as follows. Start by creating a 
chart in PowerPoint, or if you prefer, copy and paste a chart from Excel into PowerPoint. Click on 
the chart to select it, and click Animation Pane from the Animations tab to display the Animation 
Pane. Again, with the chart still selected, from the Animation tab, click Add Animation and select 
an Entrance animation such as Bounce, for example.  

 

In the Animation Pane click the drop down arrow next to the animation and click Effect Options 
to open the Bounce dialog box. Next, on the Chart Animation tab, click the Group chart drop-
down arrow and select By Series, and click OK. Thereafter, when you display the slide show, each 
data bar series will bounce in individually, helping your audience identify the specific data series 
you are discussing. The screenshot below depicts the data series for sales representative Scott as 
the bars are bouncing into position. 
 

 
 

Hints: The ability to animate charts by data series first appeared in PowerPoint 2007, and the 
instructions are similar, but not identical to those described above. This feature is not available 
in charts that contain links to other applications, such as Excel.   
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Conditional Formatting with Data Bars and Traffic Lights  
 
Beginning in Excel 2007, the format features have been expanded to 
include better styles, table formats, conditional formats, cell formats and 
more. Styles  enable users to apply a specific style, including font, font 
size, fill color, font color, underlines, borders, bolding, and italics to a cell, 
or multiple cells. Later, if you change the format style, your changes will 
automatically update all the cells that have been formatted with that 
style. Even if you never change your mind, often the use of styles can 
make formatting a large workbook quicker and easier. The “Cell Styles” 
tool offers users a gallery of predefined styles to choose form, as show 
in the screen below and to the left, or you can also create your own 
unique styles.  

        
 
The Conditional Formatting tool is vastly improved with “Data Bar” and “Traffic Light” reporting, 
as well as an improved menu for applying conditional formats. Presented below (left) are 
examples of conditional formats. Below (right) are examples of “Table Styles” that can be applied 
to data ranges. Excel 2007 also provides tools for creating your own user-defined “Table Styles”. 
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Other enhancements include new “Top/Bottom” tools and rules for displaying the top or bottom 
values in a range; “Highlight” tools and rules for displaying duplicates, equivalents, conditional 
dates, and other types of data; and “Color Scale” tools and rules for identifying specific data by 
color. 

 
Gantt Charts in Excel 
 
Excel does not produce Gantt charts out of the box; but you can still create one with a bit of Excel 
trickery, as illustrated in the following example.  
 

1. List your tasks: Start by entering a list of tasks including start dates, duration of each task, 
and end dates, an example of which is pictured below (I used formulas to calculate the 
end dates by adding the start date plus the duration days). 
 

 
 

2. Create Stacked Bar chart: Create an empty stacked bar chart by selecting any empty cell 
surrounded by other empty cells, then from the Insert tab, in the Chart group, select 
Stacked Bar, and then click and drag the desired range on the worksheet. 
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3. Launch the Select Data dialog box: Right mouse-click the blank chart and choose Select 
Data (or Select Data Source) from the popup menu.  
 

4. Reference the Start Dates: In the resulting Legend Entries box section, click the Add 
button. In the resulting Edit Series box, enter the phrase Starting Dates in the Series 
name box. Click the Select range button (the small icon depicting a worksheet) located at 
the end of the Series values box, highlight the starting date range in the worksheet (cells 
B4 through B12 in this example), and then click OK. 

 
5. Reference the Duration Days: Again, in the Select Data Source dialog box, in the Legend 

Entries box section, click the Add button. In the Edit Series box, enter the phrase Days in 
the Series name box. Click the Select range button located at the end of the Series values 
box, highlight the Duration Days range in the worksheet (cells C4 through C12 in this 
example), and then click OK. 

 
6. Reference the Task descriptions: Again, in the Select Data Source dialog box, in the 

Horizontal Axis Labels section, click the Edit button. In the resulting Axis Labels dialog 
box, click the cell Select range button located at the end of the Axis label range box, 
highlight the Tasks on the worksheet (cells A4 through A12 in this example), and then click 
OK, OK. Your progress thus far should appear as follows: 
 

 
 

7. Hide the first set of stacked bars: In the stacked bar chart, click any of the start date bars 
(shown in blue above) to select them all. Right-click on the selected bars to pop up the 
Format Data Series options panel.  Click the Fill & Line icon (the pouring paint bucket 
icon) and select No fill and No line options. 
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8. Reverse the order of the labels: Right-click on the chart’s task labels, choose Format Axis, 

and in the Format Axis panel, in the Axis Options section, check the Categories in reverse 
order box. This action will position the first task at the bottom of the chart, which is a 
Gantt chart tradition. 

 
9. Edit the date range displayed by the chart: Holding the Ctrl key down, select cells B4 and 

D12, (the first Start Date and last End Date). Change the format of these two cells to the 
General format, and make a note of these two numbers (41886 and 41931 in this 
example, but not shown above). Right-click on the Horizontal Axis (the chart’s date range) 
to pop up the Format Axis panel. Click the Size & Properties icon, and then in the Axis 
Options section set the Minimum and Maximum bounds to 41886 and 41931 (the 
numbers determined in the previous step).  

 
10. Format the date axis: Still in the Format Axis panel, under the Axis Options icon, in the 

Number section, change the Category dropdown to Date, and then change the Type to a 
short date option (I selected 3/14 in this example).    

 
11. Finishing Touches: As finishing touches: 

 
a. Add a title to your chart.  

 
b. Right-click the duration bars *(shown above in dark red), and set the Gap Width 

to 50% (to increase the width of the bars).  
c. Click the Series Options icon, and in the 3-D Format section, click the top bevel 

dropdown button and then select the Circle bevel.  
 

d. Click the Fill & Line icon, and in the Fill section click the Solid fill option and then 
select a blue color.  

 
e. If desired, you might also edit the chart’s Plot Area by inserting a picture of the 

construction project, and then adjusting the picture’s transparency to 65% so the 
chart remains readable. 

 
Presented below is the final Gantt chart report. 
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You can download this example Gantt chart file at www.CarltonCollins.com/gantt.xlsx.  

 
Excel’s New Slicer - It Slices, it Dices… 
 
CPA Question: We maintain a large amount of data for more than 100 restaurants and we analyze 
sales and expenses daily, weekly and monthly by location, city, state and territory, and even by 
type of restaurant. Overnight, the results of operations for the previous day feed into a database 
and we analyze the data in Excel using pivot tables. Despite preparing dozens of reports, my 
superiors desire more detailed reports and analysis. Can you offer a good solution?   
 
Solution: Excel 2010’s new Slicer may be the answer you are looking for. Slicer is an enhancement 
to Excel 2010’s PivotTables that inserts filter boxes that your superiors can click to display 
precisely the reports they desire. To use Slicer, position your cursor anywhere in a PivotTable 
report and from the Insert ribbon, select Slicer from the Filter group. This action will open the 
Insert Slicers dialog box shown below.  
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Place a checkmark in the checkbox for each slicer you want to display and click OK. Excel will 
insert slicer dialog boxes containing filter buttons in the worksheet for each field name you select, 
as shown below. 
 

 
 
Simply click the various filter buttons to display different views of your data. For example, the 
report below summarizes revenue for those “Dine-In” and “Drive-Thru” restaurants managed by 
“Caroline” and “Madison” in the “Atlantic” and “Great Lakes” regions. (Holding down the Ctrl key 
allows you to make multiple selections within a Slicer dialog box.) The selected filter buttons are 
highlighted and the non-selected filter buttons are greyed out, allowing you to see which filters 
have been applied to the report. 
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In the example shown above, the reader could produce up to 720 different views of this one 
report (9 States times 4 Types times 4 Territories times 5 Sales Reps). In your situation, you could 
add three similar PivotTable reports summarizing your data by week, month, and quarter, and e-
mail the entire workbook to your superiors. This would limit the total number of reports you 
would need to prepare to just four, yet provide your superiors with the ability to view the data 
thousands of different ways, according to their preference.   
 
Advanced Tip: A Slicer can be shared with multiple PivotTable reports so that when filters are 
applied in one Slicer, multiple PivotTable reports are filtered. To share a Slicer, click on the Slicer 
to be shared to display the Slicer Tools, Options tab. In the Slicer group, select PivotTable 
Connections and place a checkmark next to the PivotTables you want to share the Slicer, as 
shown below.  
 

 
 
Hint: You can resize and re-position your slicers on the worksheet, and apply matching styles to 
both the PivotTables and Slicers to produce professional looking results.  
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Timeline Slicers 
 
CPAs who work with PivotTables will likely appreciate Excel 2013’s new Timeline Slicer which 
helps users slice and dice Pivot data that contain dates. As an example, selecting the dates May 
through October on the Timeline slicer (pictured) adjusts the PivotTable to display May thru 
October data.  

 

 
Excel's New Timeline Slicer provides a  

Visual Method of Filtering a PivotTable by Date 

 
Avoiding Embedded Assumptions in Formulas 
 
It is always a good rule to not embed assumptions in your Excel formulas. The reason is that doing 
so makes it more difficult to later find those assumptions to change them, and unsuspecting users 
in the future (including yourself) may forget that there are embedded assumptions and they 
could accidentally render subsequent budgets inaccurate.  

 

  
        Wrong     Correct 
 

Explaining all Underlying Assumptions  
 
It may be obvious to all when you are preparing a budget as to where the assumptions come 
from. However, later the source of those assumptions may not be so obvious. For this reason, 
the diligent CPA will document all assumptions and formulas used so that they and others can 
easily follow the logic later.  Explanations can be documented in a variety of ways as follows: 

 

 On an administrative page 

 Next to the assumption in a cell 
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 Next to the assumption as a Comment 

 Next to the assumption as a Data Validation Comment 

 Next to the assumption using a Balloon Call out 
 

The Administrative Page  
 
For complex workbooks that are referred to frequently or used by others, it is a good idea to 
include an administrative page that helps the reader understand and navigate the workbook. 
Following is a list of potential elements you might add to your workbook administrative page: 

 

 The name of the company or client to which the workbook pertains 

 The date the workbook was first crated, and notes related to subsequent 
enhancements 

 Table of contents with hyperlinks to the various contents 

 Macro buttons for easier printing of the various reports 

 A list of authors and reviewers contributing to the template 

 An explanation of the purpose of the workbook 

 An explanation of the assumptions used in the workbooks 

 Links to external data sources referenced in the workbook 
 
Read on to see an example and learn more about creating an administrative page. 
 

Using Hyperlinks to Navigate  
 
As financial reports are created, the various calculations tend to be based on data assembled 
from a variety of sources. The financial reports, calculations, and data should not only be 
organized and well-labeled, but a hyperlinked table of contents should be inserted to aide in 
navigating the workbook, like the table of contents shown below.   
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To create a hyperlinked table of contents, list the various sections of your workbook in a table of 
contents format as shown above, then select each line and click Ctrl+K to assign a hyperlink to 
that line. Notice below that the Insert Hyperlink dialog box allows you to assign a hyperlink to 
worksheets, cells, or defined names in the workbook.  
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Using Macro Buttons to Print  
 
You can make the workbook easier to use by inserting macro buttons to print the various reports. 
To start this process, create a single text box, and use the Drawing Tools to make it look fancy as 
indicated in the screens below: 

 

      
 
Create the Print Macro – Next create a print macro by selecting “Macro, Record Macro” from 
the “View Ribbon” (make sure that no spaces are used in your macro name and save the macro 
to “This Workbook”). Set the “Print Area” appropriately to display your full budget area. Next 
simply print the full budget, then stop recording the macro by selecting “Macro, Stop Recording” 
from the “View Ribbon”. Once completed assign the Macro to the Print Sales Order Button by 
right mouse clicking and selecting “Assign Macro”.   The right click menu and the Assign Macro 
Dialog box are shown in the two screens below. 

 

      
 

Additional Macro Buttons – Next right click on the edge of the existing macro button twice, and 
or press Ctrl+C to copy it; then click away from the button and Paste the button several times. 
This will create exact copies of your macro button. (You must right click twice on the edge of the 
button to display the second menu of options.)  
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Next on the Home tab in the Editing group, select Find and Select, Select Objects. Then lasso the 
three buttons and from the Drawing Tools tab, use the alignment tools to Left Justify and 
Distribute Vertically the macro buttons. 
 

        
 
The results will appear as follows: 
 

 
 
Press escape to deselect the “Object Pointer” tool, and return your cursor to normal. In the 
future, when you want to print any portion of your budget workbook, just click the appropriate 
buttons to produce the desired reports. 
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Grouping Financial Data 
 
To group and summarize your financial data, you can create an outline of up to eight levels, by 
row or by column. Once grouped, you can show or hide detailed data by selecting the desired 
outline level as circled in the screen below. To group data, simply highlight the rows or columns 
to be grouped, and select Group from the Data tab. The resulting grouped data will appear as 
follows: 

 
 
If your data contains subtotals or grand totals (limited to 8 levels of subtotals), then Excel can 
automatically apply groups for you. To use this feature, select Auto Outline from the Group 
dropdown arrow, as shown below. 
 

 
 

Producing Budget to Actual Comparison Reports  
 
There are several approaches to comparing actual to budget data, as follows: 

 
a. Side-by-side reports, with difference and difference percentage calculations. Probably 

my favorite approach personally. To improve this function, consider grouping the 
data. 
 

b. Side-by-side columns, with difference and difference percentage columns. This might 
be a better approach in some situations.  

 
c. Over and Under reports, with difference calculations. These reports are much harder 

to compare in my opinion, but many CPAs seem to use this approach. 
 

d. Side-by-side reports, with Data Bar Formatting applied to difference and difference 
percentage calculations. While extreme data can throw off the data bars, in many 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright May 2014 – J. Carlton Collins  Page 76 

situations data bar formatting helps you quickly identify the data that needs further 
scrutiny. 

 
e. Reports without subtotals so data can be filtered, subtotaled and pivoted. Removing 

formula subtotals and inserting data subtotals is not as hard as you might think. In this 
example we will number the rows, use =RIGHT() to identify the subtotal rows, sort, 
delete the unwanted rows, then re-sort in order according to our numbered rows. 
This is a time-honored method used frequently by many CPAs to clean data and 
prepare it for analysis. From here, I will demonstrate filtering, subtotaling and pivoting 
the data as well.   

 
An Excel 2010 file containing examples of these types of comparisons is available for 
download on my web site at www.ASAResearch.com/web/actual.xlsx, or just navigate to 
the file on the Excel tab menu. Example screen shots are shown below: 
 

A.  
 

B.   
 
C. (Not Pictured) 
 

D.  
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E.  
 
As these examples illustrate, comparison reports are usually large and often confusing to 
construct and navigate. Any of the approaches described above may be more suitable than 
the others, depending upon the data, situation and personal preference. Hopefully, 
knowledge of all of these approaches will be helpful to you.   
 

Charting Budget versus Actual Results  
 
Charts can often be an effective method for comparing actual verses budgeted data. Presented 
below is an example: 

 

 
 
In this example, I have avoided using 3D chart and rotation. I have also reduced the Gap 
between the data bars which effectively makes the data bars wider. The flat chart is 
slightly easier to read than line charts or 3-D charts (because 3-D charts distort the data a 
little, and make comparisons a little more difficult.) The same chart above is presented 
below as both a line chart and a 3-D chart. 
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How Charts Lie  
 
Charts are useful tools for visualizing and analyzing data. However, charts can sometimes be 
deceiving, and CPAs should be aware of this when creating or reading charts. Below are examples 
of charting methods that may distort data. 

 
Rotating 3-D charts. The two charts shown below are identical, except for rotation. The 
red pie slice facing forward covers 107% more area (graphically) than the pie slice facing 
the rear. This technique might subliminally give the impression that the red pie slice 
represents a larger or smaller portion of the pie, depending upon your perspective. 
 

 
Picture charts. The chart below shows sales results for three salespersons. The chart 
shows that the third salesperson generated three times the amount of sales of the first 
salesperson ($3,000 compared with $1,000). Reading the chart based on data bar height, 
the chart reads accurately. However, because the data bars in the chart are taller and 
wider, the third data bar covers nine times the surface area of the first data bar, thus 
creating the illusion that sales were nine times higher.  
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3-D bar charts. The two charts below are identical, except for the 3-D effect. Notice that 
in the 3-D chart, the third data bar representing 4,000 does not appear to reach the 4,000 
hash mark on the Y-axis. By comparison, the same data bar displayed in a two-
dimensional version of the chart does perceptibly touch the 4,000 hash mark. (The reason 
for this distortion is that the front of the 3-D bar lines up with the Y-axis labels on the left 
side of the chart, but the data bar’s depth is not as great as the 3-D chart’s depth.) 
 

 
Cone charts. The two charts atop the next column are identical, except for the “cone” 
effect. Notice in the 3-D bar chart on the left, meals and entertainment expenses appear 
to represent a significant portion of the total travel expenses. However, in the cone chart 
on the right, meals and entertainment expenses visually appear to represent a much 
smaller fraction of the total travel expenses. 
 

 
 

Distorted line charts using 3-D and rotation. The three charts below depict the same 
data. The first chart is a two-dimensional line chart, which suggests an overall downward 
trend in the data. The second chart is also a two-dimensional line chart, but the maximum 
value on the Y-axis has been increased tenfold compared to the first chart, thus flattening 
the line and suggesting that there is not much of a trend in the data. The third chart is a 
3-D line chart, which has been rotated forward to emphasize the increase at the end of 
the chart. This third chart might give more of an impression that results are trending 
upward. 
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Reverse order charts. In the chart below, the data is displayed chronologically from right 
to left. In this example, revenue has actually declined over the past three years; however, 
since most people read charts from left to right, they might miss the fact that the data is 
presented in the opposite direction. 
 
 

 
 
Armed with this information, you are in a better position to prepare and read charts 
without falling into distortion traps.  
 

Managing Reviews via Workbook Sharing 
 
How does the reviewer know that once reviewed, what data was changed (if any). The answer is 
that the workbook must be Shared so that future changes can be tracked.  To use this feature, 
from the Review tab, select Share Workbook form the Changes group, and click the Allow 
Changes checkbox as shown below.  

 

 
 
Once you have shared the workbook, all changes made by yourself and others are tracked 
in Excel. Therefore, upon the next review, the reviewer will be able to tell which cells have 
changed (and how) and which cells have not changed. This makes subsequent reviews 
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much easier. To track changes, from the Review tab, select Track Changes, Accept or 
Reject from the Changes group.  The following dialog box will appear.  
 

 
 

Select the changes you want to review based on the date range in which the changes were 
made, who made the changes, and even in a selected portion of the workbook. Click OK. 
This action will launch the Accept or Reject Changes dialog box shown below, and will 
navigate to each change one at a time allowing the reviewer to click the accept button to 
keep the change and mark it as reviewed, or reject the change.  
 

 
 
Another reviewer approach that is sometimes used is to insert comments at various 
points in the worksheet as an approval sign off, an example of which is shown below.  
 

 
 

Protecting the Integrity of the Financial Reports  
 
In a famous case from the 1990’s, a disgruntled employee who had just been fired before leaving 
his office reportedly opened an Excel based budget for a proposed highway project, and changed 
the amount of concrete required from 50 million cubic yards to just 5 million cubic yards. The 
change was made after the budget had been reviewed and approved, and the employee’s 
subsequent change was not detected. The bid was sent and the company was awarded the 
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contract. The error was noticed months later as project managers compared the actual costs to 
the budget and projected a significant loss on the job. The company was able to compare the 
budget submitted to a printed version of the approved budget where they discovered how the 
problem occurred.    

 
To protect a workbook, it is a good idea to first Share the workbook so that you can track all 
changes and who made them. To further protect data to help prevent it from being changed, you 
can also specify a password that users must enter to modify the workbook. In addition, additional 
advanced protection settings also allow you to prevent users from changing the structure of a 
worksheet. 
 
Protecting A Worksheet - By default, when you protect a worksheet, all the cells on the 
worksheet are locked, and users cannot make any changes to a locked cell. If desired, you can 
unlock specific cells using the Format Cells dialog box prior to turning on worksheet protection. 
You can unlock cells for all users or for specific users. When you protect a worksheet or workbook, 
adding a password is optional. Once protected, the user must physically unprotect the worksheet 
(using the password if necessary) in order to make changes to locked cells. Presented below are 
both the Protect Worksheet and Protect Workbook tools in Excel. 

 

         
 

Copying Across the Excel Page 
 
When creating budgets, the user often has a need to copy formulas or data across long columns 
in which arrowing down thousands of rows takes too much time. In this situation, there are two 
possible approaches you can use – the piggyback approach and the end-down-back approach. 
These approaches are explained as follows: 

 
a. Piggyback Approach – (Use an adjacent column to navigate.) For example, assume you want 

to copy a formula in cell D2 down to the next 48,000 blank cells. Column A contains 48,000 
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row labels, which can be piggy-backed. In this example, copy cell D2, then move to cell D3. 
Next, holding the Shift  key down, press the LEFT  ARROW 3 times to navigate to cell A3, then 
press the END, DOWN ARROW to navigate to the bottom of column A, then press the RIGHT 
ARROW three times to navigate across to cell D48001. Release the Shift key. You have now 
selected the range in column D from cell D3 to D48001. Paste to complete the operation. 

 
b. End-Down-Back Approach – (Use the bottom of the worksheet to navigate.) For example, 

once again assume you want to copy a formula in cell D2 down to the next 48,000 blank cells. 
Column A contains approximately 48,000 row labels, but there are too many blank cells to 
use that column for piggy-back purposes. In this example, copy cell D2, then move to cell D3. 
Next, holding the Shift key down, press the END, DOWN ARROW to navigate to the bottom 
of the worksheet – cell D1048575. Next press the LEFT AROOW three times to navigate to 
column A, then Press END, UP ARROW to navigate to the last label in Column A – cell A48001. 
Press the RIGHT ARROW three times to navigate across to cell D48001. Release the Shift key. 
You have now selected the range in column D from cell D3 to D48001. Paste to complete the 
operation. 

 

Copying Down with Ctrl+D 
 
The Ctrl+D keystroke combination can be a quick way to copy data. To use this shortcut, 
highlight the cell you want to copy and the blank cells underneath where you want to paste, 
and press Ctrl+D, as shown below. 
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Hiding Data in Excel 
 
Be aware that data cannot be hidden in Excel. Even if you hide columns containing sensitive data 
and turn on worksheet and workbook protection. A user could reveal that hidden data in one of 
the following ways: 

 
a. A user could select a range of columns that contains hidden columns, then copy and 

paste that data to reveal the hidden data in another workbook. 
 

b. A user could link to a hidden cell from another workbook, simply by typing a formula 
linking to that hidden cell.  

 

Using Split Screen  
 
Excel 2007 and 2010 contain two Split tools, which allow you to quickly split the Excel worksheet 
horizontally, vertically, or both. In Excel 2013, these tools have been removed, but the feature is 
still assessable via the View tab. The Split tools make it easier to view and compare different 
portions of your data at the same time. To split your screen, click and drag the split tools to the 
desired positions. The Split tools are located in the upper right-hand corner and lower right-hand 
corner of the worksheet area in the scroll bars, as shown below. 

 

     
 

You can also access this tool by selecting Split from the Window group on the View Ribbon. Many 
users find the click-and-drag method a little faster and easier to use than the menu method. In 
the example below, the Vertical Split tool has been used to display data for the first quarters of 
2009 and 2010. (Notice that the columns jump from column E to column O). Additionally, the 
Horizontal Split tool has been used to fix the column headings at the top of the worksheet. 
(Notice that the row numbers jump from row 3 to row 7.) 
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Note: There are several alternative strategies for viewing Excel data side-by-side as follows: 

 
a. Freeze Panes. You can achieve similar results to Split by using Freeze Panes, located in 

the Windows group on the View Ribbon. 
 

b. Second instance of Excel. You can also achieve similar results by launching a second 
instance of Excel and using it to open a second (read-only) copy of your Excel file. You can 
then resize both instances of Excel in side-by-side windows. 

 
c. Formulas. For a more permanent solution, some CPAs use formulas to repeat data on a 

separate worksheet to produce a different view. For example, on Sheet2 they may insert 
formulas that refer to data in columns A, B and C next to other formulas that refer to 
columns M, N and O. Using this approach, the side-by-side comparison is always available 
without the need for the above-mentioned manual procedures. 

 
Hiding Zero Values  
 
You can hide all of the zero values in a worksheet by adjusting Excel’s options as follows: 
 

f. In Excel 2003, select Tools, Options. On the View tab, uncheck the Zero values 
box and click OK. 
 

g. In Excel 2007, select the Office Button, Excel Options, Advanced. Under the 
Display options for this worksheet section, uncheck the box labeled Show a zero 
in cells that have zero value and click OK. 

 
h. In Excel 2010, select File, Options, Advanced. Under the Display options for this 

worksheet section, uncheck the box labeled Show a zero in cells that have zero 
value and click OK. 

 

Hiding Columns  
 
Some CPAs are constantly hiding, unhiding and rehiding columns to generate reports in a 
multitude of report layouts, and they can’t figure out how to display only the hidden column they 
need without first having to display all of their hidden columns.  
 
Because hiding and unhiding columns is a frequent task for many CPAs, let’s first address this 
issue, and then I will offer a better solution using Excel’s Custom Views. To unhide a specific 
column in Excel, press the F5 key to launch the Go To dialog box and type in any cell address 
within the hidden column that you wish to unhide (such as G1), and click OK. This will place your 
cursor within column G, even if hidden. Next, while holding down the Alt key, type in order O, C, 
U to unhide the column. 
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Alternatives. Once you have highlighted a column as described above, there are many 
alternatives for unhiding columns, several of which are presented below so you can use the 
approach that works best for you. 
 

1. Using the menu. To unhide a column using the menu in Excel 2007 and 2010, from the 
Home tab, select Format from the Cells group, Hide & Unhide, Unhide Columns. To 
unhide a column using the menu in Excel 2003, select Column, Unhide from the Format 
menu. 
 
2. Using the unhide shortcut. In Excel 2003, 2007 and 2010, Windows XP users can unhide 
a column by typing Ctrl+Shift+0, but this keystroke combination is inactive by default in 
Windows 8, 7 and Vista. (Hint: Microsoft support document 967893 describes advanced 
procedures to enable this keystroke combination to work properly in Windows 8, 7 and 
Vista.) 
 
3. Adjusting column width. Instead of unhiding a column, you could simply increase the 
column width to make it visible. To do this, start by pressing the F5 key to open the Go To 
dialog box and enter a cell address to go to a hidden column. To resize column widths in 
Excel 2007 and 2010, from the Home tab, select Format from the Cells group, Column 
Width, enter the desired width, and click OK. To resize a column width in Excel 2003, from 
the Format menu select Column, Width, enter the desired width, and click OK. 

 
Advanced hint: You can make your task easier by assigning a name to a cell in each column you 
wish to hide or unhide using the Name Box (located just above the Column A heading). For 
example, you might assign the name YTD to cell G1, and the name Budget to cell H1. This will 
make it easier for you to use the Go To command because the name makes it more obvious which 
column is which. Further, you could also use the Name Box to assign a name to a group of 
columns, and use the same procedure described above to hide or unhide that group. For 
example, you might assign the name PriorYear to cells J1 through M1, and use the Go To 
command to go to those columns and unhide the entire lot. 
 

Custom Views 
 
Rather than constantly hiding and unhiding columns, a better approach might be to use the 
Custom Views feature in Excel 2003, 2007, 2010 and 2013. By creating custom views, you can 
easily toggle back and forth between all of your views. To create your first custom view, select 
Custom Views from the View tab or menu, click the Add button and enter a description in the 
Name box, then click OK. Next, hide or unhide various columns in your workbook and repeat 
these steps to create a second view of your data that includes selected hidden columns. Continue 
to create additional custom views for each of your desired hidden column layouts. Thereafter, 
you can reduce or eliminate the need to hide and unhide columns by simply changing views. To 
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toggle between custom views, from the View tab, select Custom Views in the Workbook Views 
group, and double-click the desired custom view as shown below. 

 

 

Displaying Zero Values as a Dash 
 
You can display zero values in your worksheet as a dash by changing the cell’s format to either 
the Accounting or Comma Style format. 
 

 

Using the Black Parenthesis  
 
When building a complex formula that contains nested functions or multiple sets of parenthesis, 
Excel uses colors to help you identify parenthesis pairing, and the outside parenthesis are always 
black. This tip can help you determine whether you have inserted the proper number of 
parenthesis pairs in your formula. 

 

 

Duplicating a Worksheet or Worksheets 
 
Excel allows you to duplicate a worksheet by holding the Ctrl key down and dragging the 
worksheet’s tab to the left or right. This action will insert a new worksheet, complete with the 
same headers, footers, margins, column widths, and cell contents, as the original worksheet. (In 
many situations, this method is quicker and easier than inserting a new worksheet and then 
adding headers, footers, margin settings and content.) 
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Alternative approach: To achieve the same results using the menus, select a worksheet tab (or 
group of tabs), right-click on that worksheet tab (or group of tabs), select Move or Copy from the 
pop-up menu, check the Create a copy box, and click OK. 
 
Hint 1: Using the menu approach described above, you could also copy and create a duplicate 
worksheet in another workbook. 
 
Hint 2: To duplicate multiple worksheets at the same time, select the first worksheet to be 
duplicated by clicking on the worksheet tab. Next, while holding down the Shift key, select the 
last worksheet to be duplicated by clicking on its tab. (This action will select those two tabs and 
all worksheet tabs in between.) Copy the group of worksheets by holding the Ctrl key down and 
dragging the group of worksheet tabs to the left or right. 

 
Displaying Two Digit Years 
 
Many of the default settings in Excel, including the date format, are governed by the default 
settings in the Windows operating system, as pictured in the screen below. 
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These default settings can be modified as follows: 
 
1. In Windows XP, launch Control Panel and double-click the Regional and Language Options 
icon, then click the Customize button to open the Customize Regional Options dialog box. On 
the Date tab, click the Short date format: dropdown arrow in the Short date group and select a 
two-digit date format. Click OK, OK to complete the process. 
 
2. In Windows Vista, launch Control Panel and select System and Maintenance. Next, from the 
left-hand menu select Clock, Language, and Region, then Regional and Language Options, then 
click the Customize this format button to open the Customize Regional Options dialog box. On 
the Date tab, click the Short date: dropdown arrow in the Date formats group and select a two-
digit date format. Click OK, OK to complete the process. 
 
3. In Windows 8 or 7, launch Control Panel and select System and Security. Next, from the left-
hand menu, select Clock, Language, and Region, then Region and Language, then click the 
Additional settings button to open the Customize Format dialog box. On the Date tab, click the 
Short date: dropdown arrow in the Date formats group and select a two-digit date format. Click 
OK, OK to complete the process. 
 
Note: You must close and restart Excel for any changes to take effect. Thereafter, Excel will 
display the two-digit date format you specified as the default. 

 
Cautionary point: It is important to understand that even when you are displaying two-digit 
years, you should still make it a habit to enter four-digit years, otherwise Excel may assume the 
wrong century. This is because Excel interprets two-digit years ending in 00 through 29 as years 
2000 through 2029. (For example, if you type the date 6/2/20, Excel assumes the date is June 2, 
2020.) However, Excel interprets two-digit years ending in 30 through 99 as years 1930 through 
1999. (For example, if you type the date 6/2/60, Excel assumes the date is June 2, 1960.) You can 
change the way Excel interprets two-digit years by adjusting the Calendar setting located at the 
bottom of the Customize Regional Options dialog box (shown in the left-hand column). 

 

Displaying different tabs from the same Excel workbook on two 
monitors  
 
This can be accomplished. Start by displaying Excel across both monitors as follows: Click the 
Restore Down button in the upper-right corner of the Excel window. Hover the mouse over either 
the left or right edge of the Excel window until it becomes a double arrow and drag the edge of 
the Excel window across both monitors. 
 
With Excel now spanning two monitors, display two views of the same workbook in Excel 2013, 
2010 or 2007 by selecting New Window from the View menu, then select Arrange All, Tiled, OK, 
also from the View menu. In Excel 2003, select New Window from the Window menu, then select 
Arrange, Tiled, OK also from the Window menu. This will allow you to view multiple worksheets 
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from the same workbook side by side on two monitors. In this situation, each window will scroll 
independently and best of all, updates entered into one window will automatically update the 
other windows.  
 

Note: This feature works well on monitors of the same size with the same resolution 
settings, but can yield unpredictable results if monitor size or resolution settings differ. 

 

 

Hint: To ignore other workbooks you have open, and arrange the windows for your 
current workbook only, check the Windows of active workbook box in the Arrange 
Windows dialog box in Excel 2010 (shown above), or the Arrange All dialog box in Excel 
2007. 
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Chapter 3  

Integrating Excel with your 
Accounting System 
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Exporting QuickBooks Reports to Excel  
 
Where QuickBooks fails to deliver the reports you want, Microsoft Excel picks up the slack. 
QuickBooks enables you to send reports to Excel where you can refine those reports and produce 
virtually any report or chart you envision. To facilitate this process, QuickBooks converts all totals 
and subtotals to formulas, so numeric changes you make in Excel more easily flow through to the 
bottom line. In addition, QuickBooks allows you to export reports directly to existing Excel 
workbooks, thereby updating previously exported data. As a result, if you build your new reports 
using the right formula approach, your newly created reports in Excel will update whenever you 
repeat the QuickBooks export routine. To use this approach, from the report screen select Excel, 
Update Existing Worksheet, in the Select workbook box browse to the desired workbook and 
worksheet, and then click Export. 
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QuickBooks ODBC Queries  
 
QuickBooks Enterprise provides the ability to create ODBC Queries to the QuickBooks database, 
and for a fee of $149, this capability can also be added to QuickBooks Premier at 
www.QODBC.com. Using ODBC, QuickBooks data can be queried and linked to a variety of ODBC 
(Open Database Connectivity) compliant applications, such as Excel, Access, and SQL Server. 
(Note: This tool does not currently work with Excel 2013 or Access 2013, but does work with 
previous Excel and Access editions). 

 
To use this tool, from the QuickBooks Enterprise menu, select File, Utilities, Configure ODBC. In 
the resulting dialog box, adjust the settings as desired and then click OK.  

 

 
 

Thereafter, in Excel 2010 or earlier, select Data, Get External Data, From Other Sources, From 
Microsoft Query. In the resulting Choose Data Source dialog box, select QuickBooks Data, and 
then click OK.   
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In the resulting Query Wizard – Choose Columns dialog box, in the Available tables and columns 
section, scroll to and select a table (such as the Customer table) and click the greater than sign 
(>) button to add this table to the Columns in your query section. 

 

 
 

Click Next, Next, Next, Finish, OK to complete the ODBC query and display the results in Excel. 
You can use a variety of Excel tools, such as the PivotTable tool, to manipulate the queried data. 
Thereafter, pressing the Refresh All button on Excel’s Data tab updates the query and all of the 
reports you’ve built referencing that queried data (assuming you used formulas to reference the 
data, and did not merely copy and paste the queried data). An example ODBC query is displayed 
below.  
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Preparing QuickBooks Data for Pivoting 
 
When it comes to pivoting QuickBooks data in Excel, you must first do a little bit of clean up work 
before the pivoting process can begin. In the following example, I have exported a QuickBooks 
general ledger report from 1995 to 2011, and I walk you through the process of preparing the 
expense portion of this data for pivoting, as follows. 
 
1. Remove Empty Columns – QuickBooks provides an option for exporting a general ledger 

report to Excel without empty columns, but this is not the default action. If you have not 
adjusted this default setting, then your exported general ledger report will contain empty 
columns, and you should remove them by selecting an empty column, right clicking on that 
cloumn, and selecting Delete Column. Thereafter, you can select each subsequent empty 
column and press the F4 key to repeat the deletion. 
 

2. Reformat Text Columns – QuickBooks does a nasty thing when it exports data to Excel in that 
it formats all text columns with text formatting, making it impossible to insert text based 
formulas, (which we want to do in the next step). To correct this problem, select the text 
columns and from the Home tab, select General from the Number Format drop down options 
box in the Number group.  
 

3. Delete the Non Expense Related Rows – In this example, the expense related rows begin on 
row 9490, therefore I will delete everything above that row, except the top row column 
headings. Select these rows by clicking on row 9408 (not visible in screen shot), then hold the 
Shift Key down and press HOME, then move down one row, right-click on the selected range 
and select DELETE. The data should now appear as follows: 

 

 
 

4. Insert Column Descriptions – In this example, there is no column description in Columns A & 
B, therefore we need to insert descriptions – any description will do.  
 

5. Repeat Account Description – In column B, the Account Description must be repeated on all 
subsequent blank rows below. For example, the phrase Advertising – Business shown on 2 in 
the screen image above needs to be  repeated on rows 3, 4, 5, and 6. To do this: 

http://www.carltoncollins.com/


www.CarltonCollins.com  

Copyright May 2014 – J. Carlton Collins  Page 96 

 
a. In cell B3, enter the formula =B2. 
b. Copy cell B3 by pressing Ctrl + C. 
c. Highlight the range from B2 to the end of column B’s data range, B8816 in this 

example. 
d. Press the F5 key to launch the GoTo dialog box. 
e. Click the Special button, check the radio button labeled Blanks, then click OK. 
f. Paste the data by pressing Ctrl + V. 
g. Next, select Column B and copy the entire column by pressing Ctrl + C. 
h. Select Home tab, Paste Special, Paste Values.  (Note that without this extra 

step, you will end up with formulas, and not values throughout column B, 
which will not be suitable for pivoting.) 
 

 
 

6. Save Your Work – At this point, save your work (and save it often), perhaps to a new file name 
(such as Export 2), in case power goes out or a major mistake is made.  
 

7. Number Each Row – Insert a new column in front of Column A, and number them 
sequentially. To insert numbers quickly, enter the number 1 in cell A1 and the number 2 in 
cell A2. Now highlight cells A1:A2, and doubleclick the Fill handle. This action will 
automatically number your rows down to row 8,816. 
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8. Eliminate Non Transaction Rows – The data’s transaction rows each contain a date, therefore 
sort the data by the date column, then delete all rows that do not have dates, then re-sort 
the data by column A in descending order. 
 

 
 

9. Delete Columns A & B – Delete columns A & B, as they are no longer needed. 
 

10. Format the Data – To make the data visually easier to read, format the data to your desired 
appearance. For example, I changed all fonts to Calibri and all font colors to black; I removed 
unneccessaery borders and lines; I bolded the column heading labels only; I adjusted column 
widths; and I centered certain text columns. My data now appears as follows: 

 

 
 

11.  Tidy the Debits and Credits Columns – The presentation of the debits and credits columns 
are not conducive to easy pivoting; therefore, I inserted the formula to combine debits and 
credits in the same column as shown below.  
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Next I converted the formulas contained in Column K to values using the same steps 
mentioned above (in steps 5g & 5h), labeled Column K, then deleted Columns H, I and J as 
they are no longer needed. My data now appears as follows: 
 

 
   

12. Data Review and More Cleaning – Now that the data has been cleaned from a layout point 
of view, it still must be reviewed for consistency in content as well. For example, in this data 
set we can see many problems as follows: 

 
a. Consistency – A quick review reveals that consistent account descriptins and memos have 

not been used throughout the data. For example, as shown below the phrase AT&T 
Universal Card has not been entered consistently. If you plan to summarize data using 
this phrase, then consistent phrasology is needed throughout. 

 

 
 

b. No Amounts - Some transactions have no amounts, which may be due to Voided 
transactions or other explanations. Each of these transactions should be reviewed to 
determine if that line item should be removed completely. 
 

c. Credit Amounts – Some transactions have credit balances, which aren’t expenses at all. 
Each of these transactions should be reviewed to ensure the data is a valid expense, and 
if not, consideration should be given to removing the transaction completely.  
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13. Ready for Pivoting – At this point, the data is ready for pivoting. As an example, the PivotTable 

report shown below was created in only a few seconds, including time to adjust the grouping 
of the dates listed across the report in Years. 
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Chapter 3  

Carlton’s Do’s and 
Don’ts of Financial 

Reporting 
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Carlton’s Do’s and Don’ts of Financial Reporting 
You’ve probably read a thousand financial statements in your lifetime, and scoff at the idea that 
there could more to it than you already know. Nonetheless, here are my fifteen rules for 
preparing, delivering, reading and analyzing financial statements and reports.   
 

The Whole Point is Financial Reporting 
 
Financial reporting is the most important function of an accounting system. According to the 
Intermediate Accounting textbook written by Keiso and Weygandt, “the primary objective of an 
accounting system is to summarize detailed transactional data into useful reports that 
management can use to run their business". Many businesses seem to miss this point as financial 
statements and reports are rarely produced, distributed and read on a continual basis. I believe 
that it is the job of the CPA to implement a financial reporting system that accomplishes the 
following: 
 

1. Ensure that the company’s accounting system produces accurate financial reports. 
2. Ensure that the appropriate reports are produced on a daily, weekly, and monthly basis. 
3. Ensure that those reports are distributed to the appropriate personnel. 
4. Ensure that the appropriate personnel understand how to read the reports. 
5. Ensure that the appropriate personnel are reading the reports and using the information. 

 
Too often businesses produce financial reports only after year end, far too late to allow 
executives to manage the business. There is great information in those reports, and an informed 
management team will make better decisions. 
 

Achieving the Best Reporting Possible 
 
Given the above importance of producing financial statements and reports, it is not enough to 
merely produce a few summary reports. To achieve the best possible results, a wide variety of 
reports must be produced to meet a wide variety of information needs. Accordingly, the checklist 
below is intended to help you achieve the best possible financial reporting for your company or 
client. 

 

One Number, By Itself, Is Almost Meaningless 
 

If I told you that I spent $266,548 on contract labor last month, could you tell me whether that 
was good or bad? No you couldn’t. You would probably follow by asking “How much did you 
expect to spent? Oh, a budget? Sure, we have a budget and we expected to spend $293,200 on 
Contract Labor. From these two numbers you could deduce that we were under budget and that 
is a good. 
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You might also ask me how much did you spent last month on Contract Labor, or the same month 
last year? Oh, historical amounts. Sure I can tell you that we spent $234,562 last month on 
Contract Labor and $214,036 the same month last year. Based on this new information, you 
might deduce that Contract Labor costs are up dramatically this month compared to historical 
numbers.  
 
The next time you find yourself producing a single column financial report, rethink your decision. 
Adding historical and budget comparison data could make the report far more meaningful. 
Consider the two examples below. 
 

     
      Less informative       More informative 
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Difference Reporting  
 
Displaying comparison data is helpful, but such comparisons 
should also be accompanied by “Differences” to make it easier for 
the reader to comprehend, absorb and analyze the data. In the 
example below, columns have been added to show the 
differences between actual amounts compared to budget and 
historical amounts.  
 

 
 
You might think that this tip is obvious, however I see comparison financial statements and 
reports displayed all the time with no such comparison calculations. Without the difference 
calculations, the reader is forced to make mental calculations in their head which takes more 
time and is more prone to error.  
 
Let’s remind ourselves that the goal of producing financial reports is to help management make 
decisions to manage the company.  
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Difference Percentage Reporting  
 
In some cases numerical data is more informative than percentage data; however in other cases 
just the opposite is true. Why not provide both? It is helpful to display differences as both a 
numerical and percentage amount. Remember the goal is to make it easier for the reader to 
comprehend, absorb and analyze the data.  Consider the following data: 
 

 
 
In this example, take a look at the difference column. Immediately Partner Salary draws catch 
your attention because it is a whopping $172,000 over budget. However, the $844 overage for 
Equipment Rental barely catches your attention. However, when you analyze the Difference 
Percentage column, you immediately see that Equipment Rental is 169% over budget. The point 
is that you should consider both – look for actual amounts that grossly exceed your budgets in 
terms of amounts and percentage differences, and concentrate more of your analytical efforts 
on these amounts.  
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Budgeting & Revised Budgets  
 

I used to view the budgeting process as a wasteful little chore 
that caused everybody grief and provided little benefit. But that 
view was based on bad budgeting – of course if you don’t do it 
right, poor budgeting is a big waste of time. However, if done 
correctly, budgeting can be one of the best measures you can 
take to help manage and run your business. Presented below is 
a checklist to help you ensure that budgeting is performed correctly in your organization. 
 

1. Integrated – Your budget system should be integrated with your accounting system, and 
not maintained in an outside budgeting system such as an Excel workbook. This ensures 
that the accounting system can then produce the necessary budget-to-actual 
comparative financial reports on a regular basis. 

 
2. Stratified - Budgets should be well-stratified (or categorized multiple ways). For example, 

budget data may be categorized by month (or reporting period), by segments (such as 
departments, locations, funds, etc.) and by projects or programs.  

 
3. Revisions – As conditions change, your initial budget may be rendered obsolete. For 

example, an epic disaster such as a hurricane or tsunami may have a tremendous impact 
on a charitable organization’s donations and expenditures, rendering old budgets 
obsolete. In such instances, it is prudent to generate revised budgets to follow for the 
remainder of the year. Economic conditions can change multiple times throughout the 
year and they often do. For this reason it is more realistic to consider the budgeting 
process to be an ongoing process, rather than a one-time event which occurs at the 
beginning of each year. 

 
4. Reporting – Budget amounts should flow easily to, and be included in financial reports. 

Your accounting system should produce a wide variety of comparative reports such as 
“actual-to-budget” comparisons, “budget-to-prior-year-budget” comparisons, and 
“actual and budget to budget-revision” comparisons. These reports should also present 
differences in amounts and percentages, by row; and should be available across separate 
segments such as departments, divisions, funds, etc). 

 
5. Roll Up – Budgets should be created by levels, and rolled up into various levels of 

reporting. For example, a world-wide charity with hundreds of locations would typically 
maintain separate departmental budgets for each location; by state, region, and country. 
The accounting system should allow the entity to roll up all actual and budgetary data to 
produce reports by location, state, region, and country.  

 
6. Statistical Amounts – It is often useful for an organization to budget non-financial 

amounts in addition to financial amounts. Non-financial amounts are commonly known 
as “statistical amounts”.  As examples, a homeless shelter might budget the number of 
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residents they expect to serve, or the number of meals they expect to provide; an 
association might budget the number of new members they expect to recruit; a charity 
might budget the number of magazine subscriptions they expect to sell.  

 
7. Variable Budgeting – Associated with the ability to track statistical data is the ability to 

produce variable budgets – budgets that adjust themselves automatically based on 
certain levels, such as statistical data. For example, as a charitable organization sells more 
light bulbs, the organization’s revenues and expenditures adjust automatically based on 
the number of light bulbs sold. 

 
8. Budgeting Activities – In addition to budgeting financial and statistical amounts, some 

budgeting systems allow for the budgeting of specific activities, campaigns, and capital 
projects. 

 
9. Tools – To aid in the budgeting process, it is helpful for the system to provide user tools 

for inputting budget data. For example some systems enable the user to input one 
amount for the first month, and that amount can then be automatically replicated, or 
increased by a fixed percentage or amount, to fill in the remaining months.  

 
10. Balance Sheet Budgeting – In addition to budgeting revenues and expenditures, many 

not-for-profit organizations find it necessary to budget balance sheet items such as cash 
and receivables as well.  

 
11. Import from Spreadsheet – Microsoft Excel is the world’s most popular tool for creating 

budgets and therefore a good budgeting system will support the importing of data from 
this environment.  
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Per Unit Budgeting and Per Unit Reporting 
 

In many instances, it may be helpful to also display financial 
information based on the “Per Unit” cost. This is because 
revenues and costs can vary from one month to the next due 
to volume. As volumes fluctuate, the process of comparing 
actual numbers to budget or historical numbers can be 
completely meaningless. However, the process of comparing actual Per Unit Revenue and Costs 
to Budgeted or Historical Per Unit Revenue and Costs can provide meaningful insights into your 
data. Listed below are a few industries in which volume can fluctuate widely from one month to 
the next depending upon many factors.  
 

Manufacturer – Per Units Produced 
Dentist – Per Number of Visits 
Doctor or CPA Firm – Per Hours Billed 
Airline – Per Number of Passengers Served 
Builder – Per Number of Houses Constructed 
Swimming Pool Cleaner – Per Number of Swimming Pools Cleaned 
Hotdog Restaurant – Number of hotdogs served 

 
This type of “Per Unit” revenue & cost accounting analysis can be revealing and informative. 
Consider the example below in which the Per Unit columns show which line items are askew 
when analyzed on a per unit basis. 
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As a Percentage of Sales Reporting 
 

Many industries do not produce units or measure units that 
may be used as a basis for calculating Per Unit Revenue and 
Costs; however, their Sales may still fluctuate widely enough 
from one month to the next as to make month to month 
comparisons rather meaningless. In this case, it may be 
meaningful to use a “Percentage of Sales” calculation to 
analyze and compare costs from one month to the next.  
 
For example, the financial report below displays financial data as well as “Percentage of Sales” 
calculations. Further, the final four columns calculate the percentage amount by which budgeted 
and prior month “Percentage of Sales” calculations differ from actual “Percentage of Sales” 
calculations. These changes are then highlighted by “Data Bar Formatting” to help the reader 
quickly identify those actual “Percentage of Sales” line items that fluctuate significantly from 
budget or prior month “Percentage of Sales” calculations. 
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Industry Metrics & Benchmarks 
 

Another approach to comparing data is to compare actual results to financial benchmarks of 
similar companies of similar sizes. Consider the following true story that occurred in 1998. 

 
 

In 1998 I was installing a new accounting system for a southeastern 
aluminum products company. During the installation I noticed that its 
days-in-inventory level had risen from 72 and 75 days in 1995 and 1996, to 
143 and 152 days in 1997 and 1998 respectively. Perplexed, I visited the 
local library to consult Moody’s Industrial Guide where I looked up the 
typical days in inventory for a company of that size and in that SIC code. 
This guide confirmed that average days in inventory for a company of this 
nature was 76.2 days.  
 

At that time, the company’s inventory level was valued at 
$4,635,000, but a simple math calculation revealed that the inventory level 
should have been closer to $2,323,600 (4,635,000 / 152 * 76.2). Indeed for 
the previous two years the company’s inventory was approximately 
$2,238,200 high compared to similar companies. At the time the 
company’s interest rate on its’ inventory note was 12.5% which means that 
the company had paid interest of $559,600 just to carry the additional 
inventory.   

  
 One of the reasons that management failed to detect the excess 
inventory was because no one was monitoring financial ratios. A manager 
told me that he was aware that inventory levels had increased along with 
sales and he assumed—incorrectly, as it turned out—that inventory was 
increasing in proportion to increases in sales. An investigation revealed 
that the company’s new purchasing agent who had been hire two years 
earlier simply over ordered inventory so that the they would not run out. 
This made the project managers within the company very happy as they 
did not have to deal with inventory arriving just in time in order for them 
to meet their deadlines.  
 
 The manager then explained to me that not only did the company 
needlessly spend $559,600 in excess interest in order to carry the extra 
inventory, but in fact the company had already broken ground on a new 
$4,000,000 warehouse which they now determined was not really needed.    
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There are many sources for obtaining financial benchmark 
information, and in many cases you may have to pay for that 
information. A few example sources for benchmark 
information are listed below: 

 
Moody's Financial Metrics Key Ratios by Rating and Industry: 
2009 

 
 
 
 
 

 
 

 
 

http://www.bizminer.com/reports/samples/industry-
financial.pdf  

 
 

http://benchmark.kpilibrary.com ($20 per month) 
 

http://www.finlistics.com/BenchmarkingTopDownArticle.html  
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Ratio Analysis 
 
In many companies, ratio reporting appears to be a lost art form. However, ratios can be very 
revealing, especially if monitored over time. You can find a good listing of the various financial 
ratio calculations commonly used in the Wikipedia at this address: 
 

http://en.wikipedia.org/wiki/Financial_ratio 
 
If time permitted, I would probably cover numerous ratios, show you the formulas and explain 
what they each mean. However, as CPAs, you already know about ratios. My key point is that it’s 
time to start using them. I am deeply saddened to find that virtually none of the accounting 
software products out there actually calculate financial ratios – BusinessWorks is one of the few. 
Instead I will provide you with this true story from 1981: 

 
 

In 1981 I took an internship with ITT Rayonier where it was my job to use 
Arthur Anderson’s Transaction Flow Analysis (TFA) technique to trace the flow of 
documents in the accounting systems of pulp mills. I was assigned to the pulp mill 
in Jesup, GA – (Yes I spent a whole summer in Jesup, GA, commuting each day 
from Saint Simons island).  
 

During my work I calculated the chip yield for the previous 10 years. The 
chip yield is calculated by dividing the tons of paper that is produced by the pulp 
mill by the tons of pulp wood that are delivered to the pulp mill. The results 
showed that the chip yield had fallen as shown in the chart below. 
 

 
 

I called my supervisor in Connecticut and reported the findings, and he told 
me “Carlton, there is a reason for that and if you don’t do anything else this 
summer, I want you to find an explanation”. I spent the next several weeks looking 
for answers, however no one I talked to could explain the variation. Finally, one 
hot summer day I walked across the mill yard and interviewed a seasoned worker 
who knew the answer. The older gentlemen worked the scales and weighed each 
train car as it came in to deliver pulpwood. It was his job to record the weight of 
the train car full of pulpwood, and then subtract the stenciled weight on the side 
of the rail car to determine the total amount of pulpwood received.  
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For nearly five years this gentleman had noticed when the empty trains came 
back across the scales, the stenciled weight on many of the railroad cars was 
understated. That meant that he was reporting too much pulpwood had been 
delivered. For example, he would weigh a railcar in at 66 tons, and then subtract 
the stenciled weight of 23 tons to calculate the amount of pulpwood received (43 
tons). However, the railcar actually weighed closer to 26 tons, which meant that 
the pulp mill was over paying for 3 tons of pulpwood that they never actually 
received. The scale worker had saved notes on the nearly 250 offending railcars. I 
was able to use his notes to recalculate the true amount of pulpwood received 
and the chip years calculations returned to normal. ITT Rayonier was able to go 
back to the supplier and collect approximately $250,000 in overpayments from 
that supplier.  
 
  

 
This story underscores the importance of calculating key ratios over time, and analyzing them for 
consistency. The actual ratios you calculate will vary depending upon the nature of your 
company, but at a minimum I recommend that you calculate the following ratios with regularity: 
 

1. Days in accounts payable 
2. Days in accounts receivable 
3. Days in inventory 
4. Gross profit margin percentage 
5. Current ratio 
6. Quick ratio 
7. Debt to equity 
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Event Triggered Reporting (Alarms) 
 

All businesses should ideally employ a team of accountants dedicated exclusively to reviewing 
the company's books and financial statements continuously in order to identify potential 
problems. For example, if cash balance drops below a certain level, if profit margin percentages 
dip dangerously low, or if sales taper off suddenly, warning bells should be sounded and 
management should be alerted quickly so they can initiate corrective measures. Historically, this 
process has been out of reach for most companies, as manual accounting systems required the 
need for hundreds of continuous boring calculations, which rendered such a solution 
unreasonable. 
 
However, with the advent of the computer, the evolution of application software, and the 
addition of e-mail, today's accounting systems can perform hundreds of business calculations 
continuously, comparing the results against pre-set conditions in order to identify emerging 
problems or trends. Once identified, these business alerts can be sent to the appropriate 
management personnel through e-mail, fax, or even a mobile phone. This type of reporting is 
known in programming circles as "Event-Triggered Reporting," "Alarms," or "Alerts." In business 
circles, this type of reporting is known as "Management by Exception." By any name, this type of 
reporting is being heralded as the most useful type of reporting on the planet today—and thanks 
to advancements in technology, this solution is now widely available to all businesses. 
 
Six Advantages of Event-Triggered Reporting 
 
Event-triggered reporting holds many advantages over the more traditional type of reporting, 
which typically involves the production of periodic financial statements and reports—usually 
thick, voluminous stacks of financial statements and reports. A summary of key advantages of 
event-triggered reporting is presented below. 

 
1. Immediate Reporting - Event-triggered reports alert the appropriate personnel to 

emerging financial conditions as they occur. For example, if profit margins slip, the CFO is 
notified of this event immediately—often within a few seconds. The more traditional 
monthly reporting approach might mean the CFO receives this information in report 
format several weeks later, and even then there's the chance the CFO won't notice this 
particular event simply by perusing the financial statements. 
 

2. Continuous Monitoring - Even the most diligent of employees will grow tired of 
constantly computing ratios and measures in search of significant observations or signs 
of trouble. However, an automated accounting system does not get bored—it can 
calculate numbers without tiring. 
 

3. Filtered Information - The traditional approach of producing and circulating detailed 
financial reports often inundate management with mountains of information which they 
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must wade through in order to ferret out useful information. This process can be tedious 
and time consuming. By contrast, event-triggered reporting only provides people the 
information they need to act upon. 
 

4. Efficiency - Event-triggered reporting helps people work more efficiently. For example, 
assume a customer's purchases decline for a given period. Traditionally, the sales 
manager might sift through a 400-page sales report in order to identify a customer with 
declining activity. Such laborious tasks are often set aside or even discarded. An event-
triggered reporting system instantly notifies the sales manager whenever activity for a 
given customer slips. The sales manager need only act on the information—mountains of 
paperwork are thereby avoided, or at least reduced. 
 

5. Benchmarking - When it comes to accounting, no single number is useful. To be useful, it 
must first be compared to another number. For example, knowing a company has 80 days 
worth of inventory is virtually useless. You must also fill the blanks to questions such as:  

 
• What was the number of days in inventory last month? Last quarter? Last year?  
• What is the average days in inventory for a company of our size and industry? 
• What is our budgeted days in inventory?  

  
Once a manager knows the days in inventory had been averaging 70 days over the past 
year, the industry average is 65 days, and the budgeted amount is 72 days, a call to action 
to reduce the current 80 day amount is evident. Event-triggered reporting is about 
comparing current financial conditions with benchmarks—hence, all information 
produced by this reporting process is concise and beneficial. 

  
6. Targeted Feedback - Event-triggered reports typically send notifications to only those 

people who should be privy to the information. While the CFO may be copied on all event 
triggered reports, the sales manager may see only those notifications relevant to his or 
her job. Likewise, the president may be copied on notifications pertaining to sales, cash, 
and profits, but may not be bothered with notifications indicating a particular inventory 
item needs to be re-ordered. 

  
Not Just Looking for Trouble 
 
One might assume event-triggered reporting might focus on looking for potential problems 
and troubling trends, and indeed, event-triggered reporting is well-suited for this goal. 
However, event-triggered reporting can be just as useful for identifying positive events as 
well. For example, a sales manager might want to be alerted when a customer has earned a 
new discount threshold. In this occurrence, the sales manager might receive the following e-
mail message from the alerts system: 
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Attention Sales Manager: Please call Julia Stevens and congratulate her for purchasing 
$50,000 this calendar year and earning an extra 1 percent discount on all future 
purchases. Her telephone number is 555-0100. 

 
Think how much easier your job could be if your accounting system kept you well informed 
of key events such as this. Other examples might include notification of an employee who 
achieved a perfect attendance record for the year, sales representatives who have exceeded 
their goals, or a collections manager who has set a new record for the lowest days in accounts 
receivable. 
 
Unlimited Business Alerts 
 
An unlimited number of possible alert conditions exist that might help a company better 
manage its customers, vendors, employees, and resources. All companies would most likely 
want to monitor typical benchmarks, such as cash levels, current ratios, days in inventory, 
accounts receivable, and accounts payable. They would also employ this solution to keep an 
eye on profits, interest rates, and sales levels as well. However, the accounting system can 
also alert companies about particular inventory items whose quantity are running low, 
customers who are paying too slow, or even employees who have exceeded their vacation 
and sick time quotas. The creative CFO can set up hundreds of pre-set parameters in just a 
few hours, and thereafter, the accounting system will constantly compare these conditions 
to actual results without fail for years to come. 
 
Sage ACCPAC Pro ERP, for example, not only monitors custom events, but it can alert mangers 
by sending them e-mails. As you would expect, many high-end accounting products—the so-
called beginning enterprise resource planning (ERP) products, such as Epicor, offer event-
triggered reporting. However, this high-end feature also can be found in an entry-level 
product, Peachtree Complete. Its alarms automatically monitor amounts related to account 
balances, customers, vendors and employees.  
 
For accounting software packages that don't provide event-triggered alarms, a third-party 
solution often is available. For example, the CleverPath Portal (formerly known as Forest & 
Trees) from Computer Associates can extract data from a host of accounting software 
packages, spreadsheets and other databases. In addition, the software can send you a text 
message if it spots a potential problem. Likewise, the Cisco Agent can perform similar actions. 
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Accuracy 
 

Of course this should go without saying, but financial statements 
and reports should be accurate. It seems ridiculous to mention 
this to a bunch of CPAs, however too often I encounter companies 
whose financial statements and reports are not accurate, and the 
readers of those statements know it. As a result, the financial 
statements and reports are not properly used to manage the 
business. To help ensure accuracy, follow these steps: 
 
Monthly Entries - Make sure that someone is assigned to enter 
the necessary journal entries each month. Make sure that they are entered correctly. Write up 
notes and explanations directing the bookkeeper as to the correct process. For example, explain 
that the monthly loan payment amount must be debited against the interest expense and 
outstanding loan accounts each month in differing amounts according to the amortization 
schedule. 
 
Review – Make sure that someone knowledgeable is assigned to review the financial statements 
and reports each month for errors. Create a list of key steps to take such as preparing a bank 
reconciliation, performing a physical inventory count, spot checking key balances, comparing 
actual amounts to budgeted amounts and investigating any significant discrepancies.  
 
Errors – As errors are identified, take time to determine what caused the error and train that 
person responsible so that the error does not re-occur. 

 

Reporting Frequency 
 

Financial statements and reports should be issued on a regular basis – daily, weekly, monthly, 
quarterly and annually. It has been my experience that often the bookkeeper will sit on 
information believing that it is their job to protect the privacy of all information. This is incorrect. 
Just the opposite is true, it should be the bookkeeper’s job to produce and deliver financial 
statements and reports on a continual and recurring basis. Both QuickBooks and Peachtree 
provide a tool that allows the bookkeeper to print a batch of reports with a single click. As the 
CPA, you should make sure that these batches are set up properly.  
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Electronic Reporting 
 
If possible, it is best to deliver electronic financial statements and reports via encrypted 
e-mail rather than to produce paper based reports for the following reasons: 
 
a. Paper reports take time to print. 
b. Paper reports must be delivered, faxed, or mailed.  
c. Paper reports use paper. 
d. Paper reports use toner. 
e. Paper reports result in wear and tear on your printer.  
f. Paper reports require you to go get paper, store paper, and load paper. 
g. Paper reports require you to go get toner, store toner, and load toner. 
h. Paper reports must be filed away in a drawer or filing cabinet. 
i. Securing paper reports in binders takes time. 
j. Report binders cost money. 
k. Storing report binders full of reports takes up storage space.  
l. Paper reports must later be moved to an archive room. 
m. Ultimately paper reports must be shredded. 
n. Paper reports cannot be copy and pasted into other applications such as Word. 
o. Paper reports make what-if analysis impossible without reentering the data. 
p. Paper reports make it impossible to generate a chart without re-entering the data. 
q. Paper reports are harder and more expensive to secure than electronic reports. 
r. Paper reports are more difficult to share with others. 
s. Paper reports are far more difficult to back up. 
t. Paper reports are impossible to access remotely. 
u. Paper reports do not allow the user to drill into details by double clicking a number. 
v. Paper reports do not provide search tools to make it easy to locate an account. 
w. Electronic reports can be accumulated conveniently in a single folder for easy access. 
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Automated Delivery 
 

If possible, it is best to have the accounting system automatically generate and deliver electronic 
financial statements and reports via encrypted e-mail at regularly scheduled intervals. The 
benefits are as follows: 
 
a. This eliminates the need for a bookkeeper to spend countless hours generating and delivering 

reports.  
b. This enables readers of those reports to learn to expect and rely on various financial reports 

at regularly scheduled intervals, rather than wonder when, if ever, the reports are forth 
coming. 

 
Some accounting systems provide the ability to schedule financial statements and reports to be 
delivered automatically at regularly scheduled intervals. For example, you could schedule the 
Detailed Aged Receivables report to be delivered each Tuesday and Friday at 10:00 am to the 
president, CFO, AR Clerk, and Sales Manager. As examples, both Microsoft Management 
Reporter and Crystal Reports (with the Navarre Report Scheduler Add-on) provide the ability to 
schedule the delivery of each and every report.  
 

Timely Delivery 
 

Financial statements must be delivered timely. By the 10th day of the following month, before 
information grows stale. Many companies receive accurate financial statements once a year, well 
after the end of the year – too late to be used in the decision making process.   
 
Financial reports should be delivered daily, weekly or month depending upon the company and 
various factors. For example, I would recommend that inventory re-order reports be delivered 
twice a week or even once a day in an effort to best manage inventory. 
 
The trademark of a well-run company is a continuous effort to produce and deliver deep rich 
financial statements and reports on a continuing basis.   

 

Customizing The Financial Statements and Reports 
 

Virtually every accounting system on the planet provides tools which allow you to customize your 
financial statements and reports to your specific needs. Financial statements and reports should 
be customized to include all of the pertinent information. Recipients should be asked to help 
review the financial statements and reports for missing info. 
 
In particular, statistical information such as units of sales can be added to enhance the reports. 
Many accounting systems allow the users to create new data fields which can also flow to the 
financial statements and reports for enhanced reporting. In QuickBooks, these added data fields 
can be used to filter reports as well.  
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The key point is that the seasoned CPA should do more than simply rely on the canned reports 
to meet the needs of the company. They should fully utilize the tools to ensure that the reporting 
is the best it can be. 
 

Training Users to Read and Understand Financial Statements 
 

It is not enough to merely produce and deliver the financial statements and reports. The 
recipients of those financial statements and reports should know how to read and understand 
them. This is a delicate matter, for you don’t want to insult the recipient by questioning their 
ability to read the report. Nonetheless, you should sit down with recipients and point out key 
numbers and indicators to look for when examine each report.  
 

Other 
 

In addition, there are several small tips that you should keep in mind when producing financial 
reports as follows: 

 
a. Well labeled report titles should appear on each page. 
b. Each page should be numbered using the “Page # of ##” format. 
c. The Calibri and Aerial fonts make numbers easier to read. 
d. Financial reports containing numerous zeros should suppress those zeros. 
e. In Excel, use the “Accounting Format” with the “Single” and “Double” Accounting 

underlines to achieve the look and feel that CPAs prefer. 
f. In Excel use the new “Spark Line” feature to help depict trends. 
g. In Excel use the “outlining” exploding and condensing. 
h. In Excel use “Superscripting” partially in your cell to reference footnotes. 
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J. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, tax, 
auditing, accounting systems, financial reporting, and bond financing. He is an author, lecturer, 
and technology & accounting systems consultant. He has published books, articles, and web 
pages and is the author of the monthly technology Q&A column for the Journal of Accountancy. 
As a public speaker, Mr. Collins has delivered more than 2,000 lectures in 44 states and 5 

countries addressing more than 500,000 CPAs and business professionals. As a consultant, Mr. Collins has assisted 
275+ large and small companies with the selection and implementation of accounting systems. Mr. Collins has a 
Bachelor’s degree in Accounting from the University of Georgia, is a 25+ year member of the American Institute of 
CPAs and the Georgia Society of CPAs, and is also a licensed realtor. 
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1.   Honored as one of the CPA Industries Top 25 Thought Leaders by CPA Technology Advisor Magazine 

2.   Author of the monthly Technology Q&A column for the Journal of Accountancy. 
3.   Recipient of the 2012 AICPA Lawler Award for Excellence in professional writing. 
4.   Recipient of the AICPA’s Lifetime Technical Contribution to the CPA Profession Award.  
5.   Chairman of the Southeast Accounting Show - the South’s largest CPA event. 
6.   Recipient of the Tom Radcliff Outstanding Discussion Leader Award.  
7.   Named “Top Ten CPA Technologists” by Accounting Technologies Magazine (multiple years). 
8.   Named “Top 100 Most Influential CPAs ” by Accounting Technologies Magazine (multiple years). 
9.   Has personally delivered over 2,000 technology lectures around the world. 
10.   Recipient of the Outstanding Discussion Leader Award from the Georgia Society of CPAs.  
11. Lead author for PPC's Guide to Installing Microcomputer Accounting Systems.   
12. Has installed accounting systems for more than 200 companies. 
13. Chairperson of the AICPA Technology Conference.  
14. Recipient of the ACCPAC Partner of the Year Award. 
15. Determined by SAP to be one of the country's "Top Ten Most Influential ERP Systems Consultants". 
16. Has delivered keynote and session lectures at dozens of accounting software conferences. 
17. Sworn in as a Certified Public Accountant on September 18, 1985. 
18. Member of the American Institute of CPAs since 1985. 
19. Member of the Georgia Society of CPAs since 1982. 

  
 As an auditor, Mr. Collins has audited businesses in the areas of health care, construction, distribution, automobile 
dealerships, insurance, manufacturing, and general business.  Mr. Collins' tax experience includes corporate, 
individual, partnership, fiduciary, and estate tax planning work.  In the area of finance, Mr. Collins has prepared (or 
assisted in preparing) feasibility studies and financial forecasts for nearly 300 projects seeking more than $3 billion 
in startup capital. Mr. Collins is familiar with bond issues, Medicare and Medicaid reimbursement, and conventional 
financing matters. In 1992, Mr. Collins contributed and demonstrated more than 500 pages of suggested design 
improvements to the Microsoft Excel development team of programmers - and many of those improvements are 
found in Excel today. 
 
At the University of Georgia, Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated into 
the BIFTAD Honor Society, served three years in the Judicial Defender/Advocate program, and was a member of 
Alpha Tau Omega fraternity. At Glynn Academy High School, Mr. Collins was Senior Class President, Class 
Valedictorian (1 of 6), and received a principle nomination to Annapolis Naval Academy. Mr. Collins has been married 
for 27 years and has two children. He devotes his leisure time to family, travel, tennis, fishing, snow skiing, and riding 
motorcycles (both dirt and street). Mr. Collins is president of his homeowners association, participates in the 
Gwinnett Clean and Beautiful program, and volunteers for Cooperative Ministries food drive. 
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